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E D I T O R I AL

This magazine was created using :

WELCOME TO THE LATEST ISSUE OF FULL CIRCLE.

T

his month, we have no Python, but we do have Freeplane, Inkscape, and Great Cow Basic. In
place of Python we have an interesting piece showing how you can run Linux software on
your Google Chromebook.
SJ finishes his run of Researching With Linux this month with a discussion on installing CentOS.
He'll still be around though as he brings back his old Linux Loopback column.
UBports have released OTA-5 for Touch. OTA-4 was only released a short time ago, but they're
hoping to get back to a regular release schedule now that they've done the hard work of
upgrading the underlying Ubuntu that featured in Canonical's Ubuntu Touch.
Our book review this month is on the Godot game engine. Erik (our resident cartoonist for The
Daily Waddle) is hoping to start a series of articles showing you how to create your own simple
games. Stay tuned for more info!
I won't hold you up any longer. Enjoy the issue, and (as ever) email me your thoughts on
whatever you think regarding the magazine, Ubuntu, Linux or whatever. If I don't hear from you, I
don't know if you're out there and/or enjoying the magazine. Hello? Anyone out there?

All the best, and keep in touch!

Find Full Circle on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
http://issuu.com/fullcircle
magazine
https://mastodon.social/
@fullcirclemagazine

Weekly News:

Ronnie
ronnie@fullcirclemagazine.org

http://fullcirclemagazine.org/f
eed/podcast
http://www.stitcher.com/s?fi
d=85347&refid=stpr
http://tunein.com/radio/FullCircle-Weekly-News-p855064/
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Submitted by Arnfried Walbrecht

DARPA INTRODUCES ‘THIRD
WAVE’ OF ARTIFICIAL
FULL CIRCLE 201 8
SURVEY
It's that time of the year
again where we ask what
you think of FCM, Ubuntu,
and Linux.
Some questions are a
requirement, some you can
skip over if not applicable.
Your answers will help
shape Full Circle, so please
use your constructive
criticism. If you don't tell us
what you think, or what
we're doing wrong, then
we won't know.

Survey URL:
http://bit.ly/fcm201 8

AI as enabling “reasoning over
narrowly defined problems,” but
with a poor level of certainty. The
INTELLIGENCE
second wave, it claims, enables
“creating statistical models and
he Pentagon is launching a new training them on big data,” albeit
artificial intelligence push it
with minimal reasoning.
calls ‘AI Next’ which aims to
improve the relationship between
Moving away from scripted
machines and humans.
responses is the next aim for AI. A
survey conducted at the Joint
As part of the multi-year
Multi-Conference on Human-Level
initiative, the US Defense
Artificial Intelligence found that 37
Advanced Research Projects
percent of respondents believe
Agency (DARPA) is set to invest
human-like artificial intelligence
more than $2bn in the programme. will be achieved within five to 1 0
years.
In promo material for the
programme, DARPA says AI Next
AI Next will also involve DARPA’s
will accelerate “the Third Wave”
Artificial Intelligence Exploration
which enables machines to adapt
(AIE) programme announced back
to changing situations.
in July.

T

Source:
https://www.artificialintelligencenews.com/201 8/09/28/darpa-thirdwave-artificial-intelligence/

SOLID: WEB INVENTOR
LAUNCHES FREE WEB
PLATFORM

N

o less a person than Tim
Berners-Lee, who invented
the World Wide Web (WWW) in the
early 1 990s and was ennobled for
his services, is less than ever happy
with the development the Web has
taken. "I've always believed that
the Web is there for everyone,"
Berners-Lee writes. "But [...] the
Web has evolved into an engine of
inequality and separation and is
driven by powerful forces that only
For instance, adaptive reasoning
AIE is DARPA’s initiative for the pursue their own goals." What
will enable computer algorithms to development of AI concepts that it Berners-Lee means by that are
discern the difference between the considers high-risk, but high-payoff. corporations like Google, Facebook
use of ‘principal’ and ‘principle’
The aim is to establish the
and Amazon, which collect, exploit
based on the analysis of
feasibility of such projects within a and sell the data of the user to an
surrounding words to help
one-and-a-half year timescale.
unimagined extent.
determine context.
To counter this development, he
DARPA defines the first wave of
now announces Solid. Solid is a
full circle magazine #1 38
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platform that builds on the
existing web. Solid is free software
and is designed to manage and
connect all the data a user wants
to store in it in a novel way. In
particular, all data remains private.
On the platform run apps that the
user selects. It also defines exactly
which apps have access to which
data. Data can be made available
to other users so that
collaboration is possible. While this
is already possible in broad terms
with platforms such as Owncloud
and Nextcloud, in Solid the apps
work much more together to
provide the user with a greater
benefit.
To enable Solid, Berners-Lee
has taken leave from MIT and is
returning to the World Wide Web
Consortium (W3C). Together with
John Bruce, an experienced
manager, he founded the company
Inrupt, which aims to create an
ecosystem around Solid.
Solid is far from finished, but as
with most open source projects,
developers have decided to go
public early. Solid is decentralized
and in addition to public servers
and private servers can be
operated with solid. You can
already get an identity and a pod

As expected, Arch Linux
(private data storage) and
201 8.1 0.01 also includes all the
developers can start writing apps
XCOM 2: WAR OF THE
right now. More information can be latest software updates and
security fixes that have been
found on the Solid website.
CHOSEN - TACTICAL LEGACY
released via the main archives
PACK I S COMING TO LINUX
throughout September 201 8. This
The Solid Server is an
AND MACOS
application for Node.js. He is under means that you won't have to
download hundreds of updates
the MIT license and is developed
ood news for those who own
after installing Arch Linux on a new
on Github. Binary packages are
the XCOM 2 turn-based tactics
computer.
available from the NPM website.
video game, as well as the XCOM 2:
Arch Linux is a rolling operating War of the Chosen expansion pack
Source: https://www.proas Feral Interactive says that it
linux.de/news/1 /26354/solid-web- system that follows a so-called
plans to port the Tactical Legacy
rolling release model where the
erfinder-startet-freie-webPack DLC to Linux and macOS
user installs once and receives
plattform.html
updates forever, or at least until he platforms soon after the October 9
release, which will only be
does something that breaks the
installation and needs to reinstall. available for Windows users at that
ARCH LINUX' S O CTOBER
time.
This is where the monthly ISO
201 8 ISO SNAPSHOT
snapshots come into play.
"The XCOM 2: War of the
RELEASED WITH LINUX
Chosen - Tactical Legacy Pack DLC
In other words, the Arch Linux
KERNEL 4.1 8.9
includes a collection of new game
201 8.1 0.01 is here only for new
installation, for those who want to modes, maps, weapons, armors
rch Linux 201 8.1 0.01 arrived
and Photobooth options that
today as the most up-to-date reinstall or deploy the GNU/Linux
honor the legacy of the XCOM
distribution on new computers
ISO image of the popular
without downloading hundreds of series. It will launch for macOS and
GNU/Linux distribution used by
Linux shortly after the Windows
updates after the installation,
hundreds of thousands of users
except for those that are released release on 9th October," Feral
worldwide. It's powered by the
Interactive wrote in today's
since the ISO snapshot was built.
Linux 4.1 8.9 kernel, though Linux
announcement.
kernel 4.1 8.1 0 is already in the
Source:
stable repository, and the latest
According to Feral Interactive,
https://news.softpedia.com/news/
Linux 4.1 8.1 1 kernel is in the
the XCOM 2: War of the Chosen arch-linux-s-october-201 8-isoTesting one.
Tactical Legacy Pack DLC will be
snapshot-released-with-linuxkernel-4-1 8-9-more-522992.shtml free to all owners of the XCOM 2:
full circle magazine #1 38
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War of the Chosen expansion pack
until December 3, 201 8, at 1 1 :59
pm EST. The Tactical Legacy Pack
DLC will be available for grabs
from Steam for Linux and Steam
for macOS later this month.
Source:
https://news.softpedia.com/news/
xcom-2-war-of-the-chosen-tacticallegacy-pack-is-coming-to-linux-onoctober-9-52301 2.shtml

Linux kernel's IrDA subsystem, a
flaw in the fd_locked_ioctl function
in the Floppy driver, a buffer
overflow in the Bluetooth HIDP
implementation, and a doublerealloc (double free) flaw in the
rawmidi kernel driver.

the yurex driver, the cdrom driver,
and a use-after-free flaw in the
vmacache_flush_all function.
Source:
https://news.softpedia.com/news/
major-debian-gnu-linux-9-stretchlinux-kernel-patch-fixes-1 8security-flaws-52301 1 .shtml

Furthermore, a use-after-free
bug and a potential null pointer
dereference were discovered in
Linux kernel's F2FS (Flash-Friendly M ANJARO 1 8 N EARLY H ERE
File System) implementation, a
potential null pointer dereference AS LOTS OF TESTING
in the HFS+ implementation, and a U PDATES P USHED THIS
M AJOR D EBIAN
buffer overflow flaw in WEEK
GNU/LINUX 9 "STRETCH " stack-based
the chap_server_compute_md5()
LINUX KERNEL PATCH FIXES function of the iSCSI target code.
he Manjaro Linux developers
1 8 SECURITY FLAWS
have been hard at work these
The security patch also
past couple weeks, as a steady
addresses
a
use-after-free
bug
was
ffecting the long-term
stream of testing updates have
in Linux kernel's InfiniBand
supported Linux 4.9 kernel
become available on average every
communication
manager,
and
a
used by the Debian GNU/Linux 9
couple of days. Manjaro Linux is an
variant
of
the
Spectre
V2
"Stretch" operating system series,
Arch-Linux based distro that has
vulnerability
dubbed
SpectreRSB.
there are a total of 1 8 security
seen quite a huge surge in
Mitigations are also available for
vulnerabilities patched in this
popularity this past year, as it
the
Spectre
Variant
2
flaw
for
major update that have been
focuses on overall user-friendliness
some
indirect
function
calls
used
in
discovered in the upstream Linux
and working ‘straight out of the
paravirtualised
guests.
kernel and may lead to information
box’.
leaks, privilege escalation, or
Security flaws were also
denial of service.
The great thing about Manjaro
discovered in the HID events
is that its basically Arch Linux
interface
in
debugfs,
the
Cipso
These include a memory leak in
without all of the difficulty in
IPv4 module, the Linux kernel exit actually installing Arch. Arch is a
the irda_bind function and a flaw
in the irda_setsockopt function of code used on 64-bit (amd64)
fantastic distro that typically has
systems running as Xen PV guests,
full circle magazine #1 38
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the latest in Linux technology, but
its really a headache to get up and
running, since you need to install
the base system and then all the
packages you want.
The recent slew of updates is all
leading up to the anticipated
Manjaro-Illyria 1 8.0 release, which
is expected to be available in late
October. Of course, there is
currently a beta version available
(Manjaro-Xfce 1 8.0), which includes
the latest xfce-gtk3 packages, and
the latest UI enhancements.
The Manjaro developers are
also working on a new hardware
project, called the Bladebook Fall
201 8 – it will be running Manjaro
KDE v1 8.0 preinstalled, with the
Intel Apollo Lake Quad-Core HD
APU, a fanless metal material, and
utilize eMMC as its primary
storage, although the dev states
that additional M2-SSD could be
possible.
Source:
https://appuals.com/manjaro-1 8nearly-here-as-lots-of-testingupdates-pushed-this-week/
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LINUX CODE O F CONDUCT
M IGHT SEE SOME CHANGES
B EFORE 4.1 9 RELEASE

The second patch is regarding
the CoC enforcement. At the
moment, the code mentions that
all the instances of abusing,
harassment, and unacceptable
he Linux development saw
behavior may be reported to
some big changes in the recent Technical Advisory Board (TAB); the
weeks — Linus Torvalds went on a complaints will be reviewed, and
break from Linux development,
TAB will maintain confidentiality
and a new Code of Conduct was
regarding the reporter.
also introduced to make the
community more welcoming.
James has proposed that since
the actual enforcement process is
It seems that the Code of
yet to be determined, the TAB
Conduct will see some changes
clause should be dropped until the
before Linux kernel 4.1 9 is
community decides something
released. As reported by Phoronix, concrete.
longtime kernel developer James
Bottomley has proposed two fixes.
The Linux kernel 4.1 9 release is
So let’s tell you about them in brief expected to arrive after two
—
weeks.

T

The first proposed patch deals
with the ambiguity about
collecting email address. Since the
Linux kernel development process
deeply integrates email addresses
and publishing it as a part of the
patch process, there could be
some confusion among the
developers.
So, James has proposed to add
an exception for this kind of email
address collection.

Source:
https://fossbytes.com/linux-codeof-conduct-changes-before-4-1 9release/

M AGEIA 6.1 LINUX
DISTRIBUTION NOW
AVAILABLE

W

hile many people are
familiar with popular Linux
distributions like Ubuntu, Fedora,
full circle magazine #1 38

and Mint, there are far more open
source operating systems
available. There are probably too
many, but I digress. Please know,
just because a distro isn't very well
known, doesn’t mean it's bad.

with only Live media, i.e. Live
Plasma, Live GNOME and Live Xfce
in 64bits, and Live Xfce in 32 bits. A
network installation is also
available, for users wanting more
granular control over the
installation."

One such quality Linux distro
that isn't super popular is Mageia.
Source:
It is a fork of the once wildly
https://betanews.com/201 8/1 0/06
popular Mandriva operating
/mageia-linux-61 /
system. Today, Mageia 6.1
becomes available for download. It
features LTS Linux kernel 4.1 4 and G ENTOO -B ASED CALCULATE
updated Nvidia drivers.
"This release brings all of the
updates and development that has
gone into Mageia 6 together into
fresh installation media, giving
users a kernel that supports
hardware released after Mageia 6.
The new installations will benefit
from the countless updates that
current fully updated Mageia
systems will have, allowing new
installations to avoid the need for
a large update post install," says
Donald Stewart, Mageia.
Stewart further says, "...if you
are currently running an up to date
Mageia 6 system, there is no need
to reinstall Mageia 6.1 as you will
already be running the same
packages. This release is available

7

LINUX 1 8 RELEASED WITH
LINUX KERNEL 4.1 8, FASTER
B OOT

C

oming ten months after
Calculate Linux 1 7.1 2 New
Year's Eve release, Calculate Linux
1 8 brings faster boot times to the
live ISO images, ports all the inhouse built Calculate Utilities to
the latest Qt5 application
framework, adds a new way for
managing network connections,
and updates most of the core
components and apps.
Among the new features
included in Calculate Linux 1 8, we
can mention easier installation of
Virtual Private Server (VPS) and
contents ^
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Virtual Dedicated Server (VDS),
updates installed with support for
selecting a keyboard layout and
use only one (root) position, as
well as automatic partition
detection for the text-based
installer.
By default, Calculate Linux 1 8
doesn't configure network
parameters, nor does it update it
during installations of network
management tools, adds the "-network" option to cl-setupsystem for network configuration,
and implements ALSA as default
sound system, allowing users to
adjust the sound volume in the
Cinnamon edition.
Source:
https://news.softpedia.com/news/
gentoo-based-calculate-linux-1 8released-with-linux-kernel-4-1 8faster-boot-5231 1 3.shtml

Emmabuntüs Debian Edition 2 has
been updated over the weekend to
version 1 .03, which is now available
for download. It's a bugfix release
based on the latest Debian
GNU/Linux 9.5 "Stretch" operating
system and featuring a mix of
performance improvements,
software updates, and cosmetic
enhancements.
Highlights of Emmabuntüs
Debian Edition 2 1 .03 include the
ability to execute post-install
scripts without the root password,
new and more compact postinstallation dialog windows, a new
welcome dialog, support for
Flatpak apps, a script to optimize
the Swap usage, a script for
installing the Steam for Linux
client, shortcuts to user folders,
and automatic swap activation in
live mode.

Emmabuntüs Debian Edition 2
1 .03 ships with Mozilla Firefox
60.2, Skype 8.26, HPLip 3.1 8.6, and
EMMABUNTÜS D EBIAN
2.46. It also adds the
EDITION 2 I S N OW B ASED TurboPrint
PDF-Shuffler and Gscan2pdf apps,
ON D EBIAN GNU/LINUX 9.5 a screen lock app for the LXDE
desktop environment, Bluetooth
"STRETCH "
activation management, and
oming about five months after support for mounting hard disk
drives or internal partitions
the release of version 1 .02,
without the root password. The
full circle magazine #1 38
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Emmabuntüs Wiki was updated as
well.
Other than that, this release
improves the desktop integration
and the wallpaper management
when starting Xfce, fixes various
issues with the WhiskerMenu
application launcher, Thunar
shortcuts, Chromium icon, the links
to the user directory in Cairo-Dock
configuration files, as well as the
ability to launch binaries in sbin. It
also removes FBReader and
replaces PyRenamer with
ThunarBulkRename.
Source:
https://news.softpedia.com/news/
emmabunt-s-debian-edition-2-isnow-based-on-debian-gnu-linux-95-stretch-5231 1 4.shtml

KDE PLASMA 5.1 4
RELEASED: WHAT’S N EW I N
THE POPULAR LINUX
D ESKTOP

P

lasma is one of the most
popular Linux desktop
environments around; it’s loved by
new open source enthusiasts and
veterans alike. To bring a fresh and

8

updated experience to the users,
the KDE Project keeps bringing
newer versions of the Plasma
desktop from time to time.
The latest Plasma release 5.1 4.0
has just been pushed and it brings
obvious bug fixes and new
features. So, let’s tell you about
them in brief.
For Plasma 5.1 4, the developers
have worked a lot to improve
Discover — Plasma’s software
manager and add-on installer. With
the new fwupd support, you can
now use it to update your PC’s
firmware.
The other features of Discover
include the support for Snap
channels, sorting of apps by
release date, better stability, etc.
Plasma 5.1 4 also brings
improvements and new effects to
the KWin window manager. As a
result, you can find the animations
smoother and better.
Source:
https://fossbytes.com/kde-plasma5-1 4-release-linux-new-features/
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B PFTRACE SHOULD BECOME
D TRACE SUCCESSOR FOR
LINUX

E

arlier this year, it became
known that the original Dtrace
analysis tool created by Sun thanks to a license change by the
owner Oracle - could also come on
Linux. Long-time former Sun and
Oracle employee Brendan Gregg,
who now works at Netflix, points
out in his blog the release of
Bpftrace, which he calls "Dtrace
2.0".
The now available application
Bpftrace describes Gregg as a kind
of better successor to Dtrace. The
new software not only has more
capabilities than Dtrace, but has
also been built from the ground up
with modern techniques such as
the eBPF-VM. EBPF is an almost
universally applicable virtual
machine (VM) in the Linux kernel
itself, which emerged from the
Berkeley Packet Filter (BPF).
The work on eBPF and
techniques based on it has been
done for several years, also with
the collaboration of the developer
Gregg. In addition to the VM, for
example, the BPF compiler

collection (BCC) with associated
run-time libraries is being created,
which, among other things, should
allow porting of Dtrace tools.
Bpftrace is a "complementary
extension" that offers "a high-level
language for one-line and short
scripts".
Bpftrace has progressed so far
that all Gregg's Dtrace in-line
machines now work with the new
application, which the developer
calls a "milestone". In addition
Gregg counts on his blog still some
further functions, which would like
to implement the Bpftrace
involved team still, as well as
numerous further details to the
technology.

as Punkt's take on Android.

phone handset business, but back
in the day it gave each device a
Petter Neby, founder and CEO
unique crypto identifier, and a few
of the Swiss design-led company,
years ago acquired Certicom.
told The Register Punkt's second
BSIMS is an attempt to turn a
device is coming to market this
process into a service for third
year with an unusual USP – security parties.
hardening by BlackBerry.
In the three years since the Priv
The eye-catching MP02 closely launched, BlackBerry has yet to
resembles the first 2G device,
see it rooted. BlackBerry wants IoT
designed by Jasper Morrison,
device manufacturers to adopt this
whose work spans light rail
as a quality mark. With so much
vehicles to furniture. But it's the
insecure home tat flying in from
first built on a Google-free AOSP
China, consumers and industrial
Android code base to support 4G.
buyers need all the help they can
Neither Punkt phone is cheap – the get.
MP02 retails at $350.
Source:
And it resolutely won't do
https://www.theregister.co.uk/201
WhatsApp.
8/1 0/09/punkt_mp02/

Source:
To enterprise to C-suite types,
https://www.golem.de/news/softw
Punkt opted to be the first nonare-analyse-bpftrace-soll-dtraceBlackBerry-branded ODM to use
nachfolger-fuer-linux-werdenthe BlackBerry-hardened
1 81 0-1 37039.html
manufacturing process. BlackBerry
Secure Integrated Manufacturing
Service (BSIMS) involves injecting
PUNKT: A MINIMALIST
cryptographic keys at
ANDROID FOR THE
manufacturing, the process
monitored remotely from
PARANOID
BlackBerry HQ in Waterloo,
Canada.
eaders cry out for more
diversity in the phone world,
BlackBerry is well out of the
but few alternatives are as striking
full circle magazine #1 38
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M ICROSOFT: WE' VE GOT
YOUR BACK, LINUX, HERE
ARE 60,000 PATENTS TO
PROTECT YOU

M

icrosoft loves Linux. And it
really wants to prove it. In
lieu of a wedding ring, the
company has decided to show its
dedication to open-source
software by joining the Open
contents ^
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FULL CIRCLE 201 8
SURVEY
It's that time of the year
again where we ask what
you think of FCM, Ubuntu,
and Linux.
Some questions are a
requirement, some you can
skip over if not applicable.
Your answers will help
shape Full Circle, so please
use your constructive
criticism. If you don't tell us
what you think, or what
we're doing wrong, then
we won't know.

Survey URL:
http://bit.ly/fcm201 8

Innovation Network (OIN), a
community designed to protect
Linux and other open-source
software from legal liability.
As part of its grand gesture, the
company is also planning on making
60,000 of its patents public, and
making them available to the OIN.
This should help protect Linux from
legal liability, and make those
patents available for use by the
2,400 members of the OIN free of
charge.

LINUX SMARTPHONE LIBREM
5 WILL SHIP WITH GNOME
3.32

L

ast month, Purism announced
that its Librem 5 Linux
smartphone will ship in April 201 9;
earlier, it was scheduled to arrive in
January 201 9.

library, libhandy and relevant
widgets will be soon ported to
GTK+ 4.
Source:
https://fossbytes.com/linuxsmartphone-librem-5-will-ship-withgnome-3-32/

U BUNTU TOUCH OTA-5 I S
O UT FOR U BUNTU PHONES
WITH N EW M ORPH
B ROWSER, I MPROVEMENTS

It seems that the developers will
now get sufficient time to ship
their phone with GNOME 3.32. In a
Those 60,000 patents do cover a blog post, the project urged the
large part of Microsoft's war chest, app developers to “use libhandy
ith the Ubuntu Touch OTA-4
but there will still be some
finally rebasing the mobile
0.0.4 and up, use GTK+ 3.24.1 and
exceptions. Windows desktop and
OS on the Ubuntu 1 6.04 LTS (Xenial
up and target GNOME 3.32!”
desktop application code, for
Xerus) operating system series, the
example, won't make the cut - for
UBports team can now concentrate
With the help of the new
obvious reasons. But the decision
their efforts on bringing more new
features added to libhandy and
does mark a new era for Microsoft, GTK+ fixes, developers can make
features and improvements, which
in which it may have more openwill land in the upcoming Ubuntu
their apps adaptive to both
source in its DNA than ever before. desktop and GNOME-running
Touch OTA-5 release.
It also represents a huge blow to
Librem 5 mobile device.
Microsoft's bottom line, as patent
Highlights of the Ubuntu Touch
royalties from Android smartphone
OTA-5 release include a new Morph
The post also mentions that
makers made Microsoft billions of many applications like Calls, Chatty, Browser to replace the old Oxide
dollars each year.
Browser, which is based on a more
Fractal, and Podcasts are already
recent version of the Chromium
using such adaptive capabilities;
Source:
similar work is also being done for engine, new scaling features to
https://www.neowin.net/news/micr Settings, Games, Contacts, and
display content at appropriate sizes
osoft-weve-got-your-back-linuxon various devices, including
Geary.
here-are-60000-patents-to-protectphones and tablets, as well as to
Currently, a GTK+ 3 widget
you/
full circle magazine #1 38
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display websites the way they are
designed.
Ubuntu Touch OTA-5 also brings
support for KDE's Kirigami 2
QtQuick controls for mobile
devices, which let application
developers manipulate and draw
various visual parts of apps, to
offer better integration of Plasma
Mobile apps in Ubuntu Touch, as
well as a bunch of new wallpapers,
ringtones, and notification tones
to replace the old ones.
Ubuntu Phone users using the
OTA-4 release can now update
their devices to the OTA-5 update
via System Settings > Updates.
After installing, your Ubuntu Touch
device will be rebooted
automatically for the OTA-5
update to be installed correctly.
Ubuntu Touch OTA-3 or older users
can also update to Ubuntu Touch
OTA-5, which will guide them to
setup their devices for the new
Ubuntu 1 6.04 base.
Source:
https://news.softpedia.com/news/
ubuntu-touch-ota-5-is-out-forubuntu-phones-with-new-morphbrowser-improvements523228.shtml

G OOGLE PONDERS THE

SHORTCOMINGS OF MACHINE
LEARNING

C

ritics of the current mode of
artificial intelligence
technology have grown louder in
the last couple of years, and this
week, Google, one of the biggest
commercial beneficiaries of the
current vogue, offered a response,
if, perhaps, not an answer, to the
critics.
In a paper published by the
Google Brain and the Deep Mind
units of Google, researchers
address shortcomings of the field
and offer some techniques they
hope will bring machine learning
farther along the path to what
would be "artificial general
intelligence," something more like
human reasoning.
The research acknowledges
that current "deep learning"
approaches to AI have failed to
achieve the ability to even
approach human cognitive skills.
Without dumping all that's been
achieved with things such as
"convolutional neural networks,"
or CNNs, the shining success of
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machine learning, they propose
ways to impart broader reasoning
skills.

"graph network." These are models
of collections of objects, or
entities, whose relationships are
explicitly mapped out as "edges"
The paper, "Relational inductive connecting the objects.
biases, deep learning, and graph
networks," posted on the arXiv
Source:
pre-print service, is authored by
https://www.zdnet.com/article/go
Peter W. Battaglia of Google's
ogle-ponders-the-shortcomings-ofDeepMind unit, along with
machine-learning/
colleagues from Google Brain, MIT,
and the University of Edinburgh. It
proposes the use of network
RICHARD STALLMAN
"graphs" as a means to better
ANNOUNCES “GNU KIND
generalize from one instance of a
problem to another.
COMMUNICATION
However, "many defining
characteristics of human
intelligence, which developed
under much different pressures,
remain out of reach for current
approaches," especially
"generalizing beyond one's
experiences."
Hence, "A vast gap between
human and machine intelligence
remains, especially with respect to
efficient, generalizable learning."
In response, they argue for
"blending powerful deep learning
approaches with structured
representations," and their
solution is something called a
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G UIDELINES”

I

t seems that the GNU Project
isn’t unaffected from the
development happenings in the
land of Linux. After Linux kernel
community introduced its Code of
Conduct to make the contributors
and maintainers follow certain
rules and make the community
more welcoming to the new
contributors, Richard Stallman said
that strict of conduct are
“repressive and rigid.”
In the latest development, he
has announced “GNU Kind
Communications Guidelines.” The
initial version of the guidelines is
contents ^

NEWS

available online and Stallman has
improvements and bug fixes to
requested the GNU contributors to make the KDE Plasma 5.1 4 desktop
follow them.
environment more stable and
reliable. Highlights of this second
In his announcement post,
point release include firmware
Stallman talks about the ongoing
updates improvements and better
discussion regarding GNU
Snap support in the Plasma
development pushing away new
Discover software manager.
contributors, specially women.
KDE Plasma 5.1 4.2 also adds
Comparing it to Linux’s new
accessibility information to
Code of Conduct, Stallman calls
desktop icons, addresses a typo in
them different on the fundamental the GTK theme treeview style for
level — while Code of Conduct
the Breeze GTK theme, lowers the
punishes those violate it, GNU Kind Qt dependency for plasmaCommunication Guidelines tries to browser-integration to version 5.9,
help people learn how to
improves focus handling in Plasma
communicate with kindness.
Desktop, and updates Plasma
Networkmanager (plasma-nm) to
Source:
display the right current download
https://fossbytes.com/richardand upload speed.
stallman-gnu-kind-communicationguidelines/
Among some other noteworthy
changes included in the KDE
Plasma 5.1 4.2 point release, we can
mention a fix for a bug discovered
KDE PLASMA 5.1 4.2
in Plasma Workspace, which made
D ESKTOP ENVIRONMENT
Plasmashell freeze when
attempting to get information
I MPROVES FIRMWARE
free space from mounted
U PDATES, SNAP SUPPORT about
remote filesystems after losing the
oming just one week after the network connection to it, and
better compatibility with Firefox
first point release, the KDE
Plasma 5.1 4.2 point release is here 58 and later for the bookmarks
runner.
with yet another layer of

C
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Source:
https://news.softpedia.com/news/
kde-plasma-5-1 4-2-desktopenvironment-improves-firmwareupdates-snap-support523381 .shtml

WANT TO RUN LINUX O N
ANDROID WITHOUT
ROOTING ? U SING
U SERLAND

easier and lets you run Linux
distros like Debian and Ubuntu.
The major highlight of this app
is that it doesn’t demand root
access from you. It’s a big relief as
rooting also exposes one’s device
to numerous security flaws and
warranty hazards. You can use it to
install/uninstall apps like any other
regular application.

To use the app, you can use
either run single-click apps or make
use of user-defined custom
ust recently I came across a
new app on Google Play Store sessions. The second method
that can help you run Linux on your involves defining the filesystem
and services (vnc or ssh) you wish
existing Android smartphone.
Named UserLAnd, this application to use. After this, the app
is fully open source, and its code is downloads the necessary files, sets
up everything, and connects to the
available on GitHub.
server.
The latest 1 .0.0 version of the
Source:
app follows the last beta release
https://fossbytes.com/userland0.5.3, which was under
linux-apps-distros-on-android-nodevelopment for the past few
months. So, let’s tell you what the rooting/
free UserLAnd app has to offer.

J

You must be knowing that
Android is based on a modified
Linux kernel. So, it makes sense
that you can use Android to run
Linux commands and use tools like
ssh? UserLAnd makes these things
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LINUS TORVALDS D ISCUSSES
H IS RETURN TO LINUX
D EVELOPMENT

F

ollowing the release of Linux
kernel 4.1 9, the 4.20 (or 5.0)
contents ^
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merge window is now open. Linus
Torvalds is also back at the driver
seat to take care of the Linux
development.

“If real issues do come up in the
future, we will address them then,
as we always have the option to
change and revisit things as
needed,” he added.

At the Linux’s Maintainers’
Summit in Scotland, Torvalds spoke
Source:
with ZDNet and discussed the
https://fossbytes.com/linusfuture plans and recent
torvalds-return-to-linuxdevelopments.
development/
In the interview, he expressed
relief over the fact over that now
Greg Kroah-Hartman also has the
write rights to the kernel tree. This
will obviously reduce some
pressure off Torvalds’ shoulders. In
the future, he also plans to add
another maintainer.

PINEPHONE: PINE64 I S
M AKING AN AFFORDABLE
LINUX SMARTPHONE
RUNNING KDE PLASMA

F

ollowing the demise of Ubuntu
Phone, Purism’s Librem 5
Now comes the biggest part: his
seems like the next big thing in the
decision to take some time off.
budding world of Linux
smartphones. Purism has already
He said that the progress on a
partnered with big names like
personal level is a continuing
GNOME and KDE, and we can
process and “for now I have an
expect the device to start shipping
email filter in place.” Torvalds is
in April 201 9.
also talking to a professional to
improve his behavior.
It seems like another hardware
vendor is looking to develop its
Talking about the much talked
own Linux smartphone. As
about Linux Code of Conduct,
Torvalds said that he wants it to be reported by It’s FOSS, Pine64 is
working to create inexpensive
left alone for now and people
shouldn’t worry about hypothetical Linux-based smartphones and
tablets.
situations.
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KDE Neon creator Jonathan
Riddell revealed this at Open
Source Summit, Europe Edition.
Upon contacting Pine64 founder
TL Lim, It’s FOSS found that the
devices are called PinePhone and
PineTab — so, no surprises there.

FULL CIRCLE
WEEKLY N EWS

Starting November 1 , Pine64
will start shipping the first
PinePhone developer kits to the
selected devs for free. The kit will
include baseboard, SOPine
module, 7! Touch Screen Display,
Camera, Wifi/BT, Playbox
enclosure, Lithium-Ion battery
case, and LTE cat 4 USB dongle.
As per the current schedule,
Plasma Mobile-running
PinePhone’s actual design won’t be
finalized until 201 9 Q2.
As Pine64 is known for its lowcost laptops, PinePhone won’t
break your backbone when it
comes to pricing. You can expect
this open source Linux smartphone
to cost $1 00+ for 2GB RAM and
1 6GB storage variant.

Join our new hosts Wayne
and Joe as they present you
with a short podcast
(<1 0min) with just the news.
No chit-chat. No time
wasting. Just the latest
FOSS/Linux/ Ubuntu news.

RSS:

http://fullcirclemagazine.
org/feed/podcast

Source:
https://fossbytes.com/pinephonepine64-affordable-linuxsmartphone-kde-plasma/
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M a n a g i n g A CV I n La Te X

Written by Lucas Westermann

he last month has been spent
once again updating my CV. I
do this quite frequently in order to
keep it as up-to-date as possible
when it comes to my skills and
experiences. That way, if someone
asks for my CV, I’ll have something
to send them quickly. The problem
with this is that the CV I update is
massive (to contain all the possible
information), and I always need to
copy-and-paste sections into a
tailored CV for whichever position
I want to apply to. This is tedious
and error-prone - I’d much prefer a
DRY (don’t repeat yourself)
method so I need to update my
information in only one spot. Enter
LaTeX.

WHAT IS LATEX?
LaTeX is a markup language
that is very popular with the math
and science fields, due to its ability
to easily represent mathematical
equations. For the use case we’re
covering in this article, however,
we’re mainly focused on the ability
to define your own reusable
snippets.

EXAMPLE?

Once you’re done with the
preliminaries, I’d also recommend
I decided on this approach while finding a nice template that
looking at various CV templates in appeals to you, and download an
example into this new folder to
LaTeX. In the Further Reading
work with. Since everyone may be
section, you’ll find a link to the
selection of templates I ultimately working with a different template,
I will try to keep the instructions
chose (specifically, the sidebar
one). As such, instead of creating a generalized so anyone can follow
along.
placeholder CV for this article, I
will instead refer to the examples
in that repository.
H OUSEKEEPING

G ETTING STARTED
What you’ll need to do is install
LaTeX. My recommendation is to
install Texmaker (an editor for
LaTeX) and let it pull down the
dependencies. This will take a
while, as the files are quite large.
Next, you’ll want to create a
nice folder to place your files in.
This is the folder that will contain
your .tex file, as well as the
resulting PDF files and any
temporary or supplementary files
you may need (i.e. pictures). I
therefore recommend that you use
a new, empty folder for this.
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Once you’ve downloaded your
template, you may discover that
there are multiple files, or that
there is one single large file. If
there is only one file, you’ll want to
split it up as I outline below. If the
template is already segmented in a
similar manner, jump onto the next
section.
• Check for the start of the file
(defined with \begin{document}).
Everything before this should be
moved into a separate file (called,
for example, preamble.tex)
• Once the preamble.tex file is
created, you’ll want to import it
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back into the original file. To do
this, place \input{preamble} at the
start of the file (before
\begin{document}). The reason for
this is simple - now you can
guarantee a shared library of
functions and styling that you can
re-use in multiple CVs.
• If you want to clean up
preamble.tex by inserting or
removing comments for better
legibility (or perhaps to make
space for your future additions),
do that now.
• I’d also recommend setting the
correct paper type (such as a4
[a4paper] or letter [letterpaper]) in
the \documentclass definition.

CREATING CUSTOM
COMMANDS

Once you’ve created your
preamble.tex file, you should
compile the main template file.
This is to make sure that it still
works correctly, and to get an idea
of how your information will be
styled/placed on the page.
contents ^

COMMAND & CONQUER
Typically, there will be a few
guaranteed sections to a CV: Skills,
Experience, Education, and contact
information. If you need another
section (or your template has an
area for something else), then the
approach will be the same.

SKILLS
The template I used indicates
the skills using some sort of icon
and label in a list in the sidebar.
Depending on your template, you
may need to adjust the actual
code. I recommend copying the
existing example data while
creating your new command.
The snippet below can now be
called anywhere that imports
preamble.tex with \webSkills. If I

\newcommand{\myEducation}{
\cvevent{3000-3004}{Bachelor of Science (Honours) Flying Cars}{University of
Mars}{Bachelor project: Creating a perpetual fuel starship for interstellar travel.}
\cvevent{2995 - 2999}{Intergalactic Baccalaureate}{Intergalactic School Station of
Neptune}{Member of the Young Space Rangers}
}

need to make a change, I can
simply make the changes in the
preamble and then recompile the
actual CV I need updated.
Depending on how finely you need
to divide the information up, you
could create commands for
common groups or even for
individual skills so you can mix and
match in the CV file. Be careful you
don’t slice it up so much that
you’re essentially still writing an
entire CV every time.

\newcommand{\webSkills}{
\textcolor{white}{
\icontext{Code}{12}{JavaScript}{white} \\[6pt]
\icontext{Code}{12}{Meteor}{white} \\[6pt]
\icontext{Code}{12}{Ruby/Ruby on Rails}{white} \\[6pt]
\icontext{Code}{12}{Python}{white} \\[6pt]
\icontext{Code}{12}{PHP}{white} \\[6pt]
\icontext{Code}{12}{Go}{white} \\[6pt]
\icontext{PaintBrush}{12}{CSS}{white} \\[6pt]
\icontext{PaintBrush}{12}{HTML}{white} \\[6pt]
\icontext{Database}{12}{MongoDB}{white} \\[6pt]
\icontext{Database}{12}{SQL}{white} \\[6pt]
\icontext{CodeFork}{12}{Git}{white} \\[6pt]
}
}
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EDUCATION
This is the last specific code I’ll
be sharing. The other areas can be
done in the exact same method.
The reason I cover education as
well is because I call more
complicated custom commands
within \myEducation. The details
have been fictionalized for the
sake of this article (why they
ended up so sci-fi, I don’t know!).
You can also include formatting
in these custom commands,
though I would only do so if you’re
pretty certain they won’t change.
Otherwise, you’ll want to style
them in the individual CVs.

CALLING CUSTOM
COMMANDS

Calling these commands are
pretty simple. A barebones
example would be:
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\input{preamble}
\begin{document}
\myEducation
\webSkills
\end{document}

Naturally, you’ll want to format
and place the information in the
relevant sections of the template.
The upside to the template is that
you will be given styling
information you can tweak, instead
of creating all of this from scratch.

CONCLUSION
Hopefully this article will help
others who, like me, want to keep
a running database of skills for
their CV that they can reuse. If you
know of templates for LaTex that
you enjoy using (or have created),
feel free to send me a link. If you
have questions, comments, or
suggestions, I can be reached at
contents ^
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lswest34+fcm@gmail.com.

FURTHER READING

THE O FFICIAL FULL CIRCLE APP FOR U BUNTU TOUCH

B

rian Douglass has created a

fantastic app for Ubports
Touch devices that will allow you to
view current issues, and back
issues, and to download and view
them on your Ubuntu Touch
phone/tablet.

https://github.com/jankapunkt/lat
excv - Collection of LaTeX
templates for CVs.
https://wch.github.io/latexsheet/ Cheatsheet for LaTeX syntax.

I NSTALL
Either search for 'full circle' in the
Open Store and click install, or view
the URL below on your device and
click install to be taken to the store
page.
https://uappexplorer.com/app/
fullcircle.bhdouglass

Lucas has learned all he knows from

repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.
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R u n L i n u x Ap p s O n A C h ro m e b o o k

Written by Rob Lindsay

Following this advice, I was able
hree days ago, my HP
to
use
crosh to open a container,
Chromebook 1 1 G5 acquired
the ability to load Linux apps when run xclock and Visual Studio Code.
Chromeos was updated to Version
Initially having opened a crosh
70.0.3524.2 (Official Build) dev (64window
[Ctl + Alt + t], I typed:
bit).
Since then, I have been busy
learning how to implement this.

vmc start dev

and was rewarded with - (termina)
chronos@localhost ~ $

This indicates that you have a
functional VM. You have to wait a
while for the VM to download.
Next, you need to

run_container.sh -container_name=stretch -user=rob --shell

but substitute your user name for
'rob'.
This downloads a Debian
Stretch image and takes quite a bit

It is rather exciting - given my
past experience with this machine
and the decision to remove
Developer Mode because of
security considerations. Developer
Mode and Crouton had allowed me
to run Chromeos and UbuntuMate
at the same time, but made the
machine much less secure than one
running Chromeos normally.
It is now possible to create a
Crostini VM and Linux container
very easily, and there is no security
compromise when starting the
machine.
A few Googles on the internet
quickly resolved what was needed
to initiate the VM and container see below.
full circle magazine #1 38
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of time unless you have masses of
bandwidth.

Stellarium, Sublime Text and Visual
This HP Chromebook 1 1 G5 Studio Code. When you load Gimp, with 4 MB RAM and a 1 6 GB drive,
you end up with ImageMagick as
is a bit lacking in space for Linux.
Once the required files have
well.
been downloaded
4 MB RAM & a 32 GB SSD/emmc
Although I loaded Chromium
would be better. A touch screen
rob@stretch ~ $
yesterday, and used it to access
for the grandchildren and
Dataplicity for upload and
Storytime would be nice too!
appears.
download of files through
Nextcloud on my RASPI, this is not
Now have icons for Gimp,
Using Terminal which appears in necessary.
Inkscape, Scribus, Stellarium,
a Linux app group after the VM is
Sublime Text, Terminal and Visual
downloaded is much easier
When Terminal is working
Studio Code as a Linux group on
because you don't have to supply
properly, it is possible to upload
the shelf.
‘run_container.sh -and download files through the
container_name=stretch -Chromeos Files Linux (Beta) folder.
The Google team appear to
user=rob --shell’ - each time you
have
done a brilliant job of
initiate the container after starting
Have now removed Chromium. integrating Linux with Chromeos,
the VM. Clicking on the Terminal
given their system security
app starts both VM and container.
Have worked on files in Gimp,
guidelines.
Inkscape and Scribus, and moved
My standard Linux load is nano, them between Linux and
They are keen to make Linux
wget, Gimp, Inkscape, Scribus,
Chromeos.
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tools, editors and IDEs available to
Chromebook users, especially
developers.
In addition to Sublime Text and
Visual Studio Code, have loaded
Atom, Bluefish and Brackets - all of
which work normally. Atom,
Brackets and Visual Studio Code
need additional repositories to be
added. Hence the need for wget.
References:
From scratch to VS Code _
Crostini.mhtml, Crostini 1 01 _
Crostini.mhtml and What Linux
apps on Chrome OS means for
open source - TechRepublic.mhtml.
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F re e p l a n e - P t 9

Written by Elmer Perry

hen building a map, I often
find it useful to tag or mark
a node. This is especially helpful
when my map is about a project or
a group of projects. Freeplane's
attributes feature does the trick as
it lets you create a property/value
pair. Freeplane keeps track of
these attributes and the values
you assign to them. You can even
lock the list of possible values for
certain attributes. In this article, I
will explore the use of attributes.

ADDING AND EDITING
ATTRIBUTES

There are several methods for
adding and editing attributes. The
most useful being Edit > Node
extensions > Edit attribute in-line.
You can also find Edit attribute inline in the right-click menu. Lastly,
you can use the shortcut keys ALT +
F9. If the selected node doesn't
have any attributes, Freeplane
adds a blank pair. The left blank is
for the attribute, and the right
blank is for the value. You can type
in a new attribute name or use the
dropdown arrow to select an
existing one. You can type in a
value in the right blank or press
the ENTER key to get a dropdown
list. The list includes values already
assigned to the attribute.

you get a context menu. ‘Optimal
width’ scales the width of the table
columns to fit the longest text in
the column. ‘New attribute’ creates
a row for you to add an attribute to
the node. ‘Delete’ removes the
selected attribute from the node.
Up and Down moves you up and
down the rows of attributes. (You
can do the same things with the up
and down arrow keys.) If you rightclick on a value in the table, you
get a context menu that includes
the ability to add hyperlinks. You
can add a link by choosing the file
or typing in the URL/path. You can
add a link to a node, too. You can
use the mailto method as outlined
in Part 8.

If there are attributes assigned
to the selected node, you can use
the arrow keys to move around in
the table. You can change the
attribute by using the dropdown
list or by typing a new attribute
name. When editing the value, you
press the ENTER key to get a
dropdown list of assigned values,
or type in a new value.

Press the ESC (Escape) key to
exit the edit mode or select a
different node.

When you add an attribute to a
node, the menus View > Node
attributes determine whether it
shows. ‘Show selected attributes’
will display only the attributes
tagged as selected. Later, I will
show you how to set the select tag.
To display all attributes below the
node, select ‘Show all attributes’.
‘Hide all attributes’ will show no
attributes. Use the Show icon for
attributes to display the attributes
icon on the node core. If you hover
over a node with attributes, all the
attributes will show in a pop-up.
Another way to add attributes
is through a dialog. Use the menus
Edit > Node extensions > Add
attribute in dialog. The dialog has
two dropdown lists and two
buttons. From the Attribute Name

If you right-click in the table,
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dropdown list, you can select an
existing attribute, or you can type
in a new name. The Attribute Value
dropdown list lets you select an
existing value, or you can type in a
new one. Click the OK button to
assign the attribute to the selected
node, or the Cancel button to
discard.

There are four columns across
the top of the dialog: Attributes,
Selected Visible, Restricted Set,
and Edit. The Attribute column
lists the active attributes in the
map. You can check the Selected
Visible column to change how the
attribute shows in the node. If
checked, the attribute will display
below the node. If unchecked, the
To copy the attributes on a
attribute shows only when you
selected node, use the menus Edit hover over the node. This is
> Node extensions > Copy
dependant on the attribute’s view
attributes. Select the node you
settings. Restricted Set locks the
want to copy the attributes to. To values for that attribute to those
paste the attributes use the menus already in the map. Use the Edit
Edit > Node extensions > Pastes
button to change the list of values.
attributes. It is not possible to copy
selected attributes. You are
copying all the attributes of the
node.

ATTRIBUTE M ANAGER
The Attribute Manager lets you
add, remove, and edit the
attributes and values for the map.
The manager dialog is a onestop/do it all for managing the
attributes in a map. You can
specify which attributes are
selected and which are not. To
open the Attribute Manager, use
the menus Edit > Node extensions
> Attribute manager.

delete. To add a value, type the
new value in the text box and click
the Add button. To rename a value
select the value to change, make
the change, and click the Rename
button. You delete a value by
selecting the value and clicking the
Delete button. Click the Close
button to return to the Attribute
Manager dialog.

and values you want to import and
click the OK button. Click the
Cancel button to close the dialog
without importing any attributes.

The first entry in the manager is
All Attributes. This entry is used to
make changes related to all
attribute names. The other rows
allow you to edit values of specific
attributes. Checking the Selected
Four buttons line the bottom of Visible makes all attributes visible
the Attribute Manager dialog. The under the node. Unchecking makes
OK button saves your changes and all the attributes show only when
closes the dialog. Click the Apply
the mouse hovers over a node. The
button to save your settings
Restricted Set locks the addition of
without closing the dialog. The
any attributes except in the
Cancel button closes the dialog
manager. The Edit lets you add and
and discards any changes. The
remove attributes from the
Import Map button opens a dialog current map. It works the same as
that allows you to import
the values dialog, but you are
attributes and values from any
adding and removing attributes
open maps. Select the attributes
instead of values.

The Edit dialog has a list of the
current values, a text box, and
buttons to add, rename, and
full circle magazine #1 38
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TOOL PANEL
In the Tool Panel on the
Calendar and Attributes tab, you
find one more place to add

FIND AND REPLACE
ATTRIBUTE

button will replace the top pair
with the bottom pair. The Close
button closes the dialog.

In the menus, Edit > Node
extensions > Find and replace
attribute brings up the Extended
attribute editor. The two radio
buttons at the top determine the
nodes affected by your search and
replace queries. You can pick from
Selected nodes and All visible
nodes. The checkbox Skip root
node determines whether to
include the root node in the
search. Two sets of combo boxes
allow you to select or enter
attribute/value pairs. The Add
button applies the top attribute
pair to the indicated nodes. To
remove a certain attribute from
the node, select it in the top pair
and click Remove all values button.
The Remove this value button will
remove only the attribute/value
from the top pair. The Replace with

ATTRIBUTE FROM STYLE
In the style editor, you can add
attributes to a style. When you
assign a node to the style, the
attributes aren't added to the
node. You apply the style
attributes through the menus Edit
> Node extensions > Attribute
from style. This assumes the node
is assigned to a style and the style
has attributes. In the style editor,
you find the attribute options in
the Edit > Node extensions menu.
Remove Attributes
In the menus, Edit > Node
extensions > Remove attributes,
you have options to Remove first,
Remove last, and Remove all
attributes.
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attributes to nodes. But in the
panel, you get a feature not found
elsewhere, the ability to format
the values of the attributes.
The attribute section is at the
bottom of the tab. The New
attribute button adds an attribute
to the selected node. The Optimal
width works in the same way as it
does in other places. The Value
format will open a list of formats.
You will recognize many of these
from the article on core text
formatting (Part 8). Select a format
to apply to the attribute value. The
format is applied only to the
currently selected value.
The right-click menus are the
same as those when editing the

21

attributes in-line.

FILTERING AND SEARCHING
NODES BY ATTRIBUTES

In the filter toolbar or the filter
composer, the attribute names
display in the left-hand dropdown
list. The right-hand dropdown list is
available for selecting defined
values. Select the comparison
operator from the middle
dropdown list. All comparison
operations consider the data type
of the values (text, date, time,
number). The status bar shows the
type of the selected value.
Attributes are a great way to
tag and identify nodes for a certain
purpose. You can add attributes inline or through the Attribute
manager. In the Tool Panel, you
have an option to format the
values on the Calendar and
Attributes tab.

Elmer Perry is a technical support

rep for an international keyless
access company. He enjoys writing,
woodworking, and technology. He
lives in Leicester, NC with his wife.
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Written by Boris Breur

n FCM#1 36, I showed you how to
use the analog to digital
conversion (ADC) with a lightdependent resistor (LDR) to gather
information about the ambient
brightness and how to
communicate to a remote device
at distance.
The reception with the
standard receiver was bad, so I did
some research, and ordered
another receiver-module to
improve the reception, it is called
“RXB8 V2.0” and came at a
reasonable price. In this issue we
will enhance the Radio Frequency
(RF) device interface to save some
power - to do this I will introduce
the Watchdog timer.

I NTRODUCING THE
WATCHDOG TIMER
Imagine a situation where you
program a microcontroller for a
critical system. You would not just
rely on the reliability of the
software to avoid damage, would
you?

Software can always contain
bugs, or maybe some
environmental conditions arise
that you did not think of in the first
place. So, it would be important to
restart the microcontroller to its
initial state if something goes
wrong. In such situations you
surely will use the watchdog timer,
which can restart the
microcontroller completely. With
respect to low ressources, another
use case of the watchdog timer
would be to implement a power
saving mode to save battery life.
The device drains as little battery
as possible (whilst sleeping) and
can then use the watchdog timer
to wake up. So how does the
watchdog timer (WDT) work
internally?

G re a t C o w B AS I C
to wake up the device, or to
timeout operations that last too
long.
• The system reset mode is quite
self-explanatory, the device is
restarted without further notice
and all volatile data is erased.
• The remaining mode combines
the aforementioned ones, the
interrupt occurs and you can
implement a routine where you
save your data or send some
debugging information (eg, over
the UART), and then the system is
reset.

The WDT can be activated in
two ways:
• By setting a hardware fuse
(WDTON): in this mode the WDT is
set to ‘system reset’ mode and
cannot be changed or switched off
The watchdog timer has a
by software on the fly. Only the
separate on-chip oscillator working overflow of the WDT can be
at 1 28 KHz which works as a
prevented by resetting it.
overflow timer. Thru a prescaler,
you can set the time when the
overflow occurs. The WDT can
operate in three modes: interrupt,
system reset or interrupt and
system reset:
• The interrupt mode can be used
full circle magazine #1 38
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• The WDT can be activated by
software: then all three modes can
be used. For the ATtiny1 3a,
different timings can be set (to
trigger overflow). For this article
we need to know only two timing
options.

LED FLASHER WITH THE
WATCHDOG TIMER

The WDT needs a timed
sequence, without interruptions,
to be changed or switched on and
off:
• First, make sure that Interrupts
are off.
• Reset the WDT.
• The watchdog change register
(WDTCR) must be set to logic 1 in
the watchdog change enable bit
(WDCE).
• Enable the watchdog and set the
prescaler of the watchdog timer.
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Compile the code shown right
and upload it to the ATtiny1 3a,
connect a LED to PortB.1 , and see
what happen.
The program starts, the LED is
turned on and activates the WDT.
After 64 ms the microcontroller
restarts.

The ‘boot time’ by default is
about 64 ms according to the
factory default. In this setup, the
microcontroller is just reset - no
power-save mode is used just yet.
The LED flashes relatively fast
because of the short time the LED
is set to on (64 ms).

POWERSAVE MODES
The ATTiny1 3a has three
different power-save modes, each
of them with more or less power
consumption. In sequence by
power-consumption (from highest
to lowest) they are: Idle, ADC
Noise Reduction and Power-down.
The choice depends on the
situation, and what you want to
achieve with your device. For now,
we’ll use power-down mode. The
other sleep modes will be
explained in a further article, when
they are needed. To get an idea

#CHIP tiny13a, 1.2
#OPTION EXPLICIT
‘provide that variables are dimensioned before use
#OPTION VOLATILE PortB.1
‘avoid glitches on the LED
#DEFINE LED PortB.1
‘LED on PB1
SET PortB.0 = 1
SET PortB.2 = 1
SET PortB.3 = 1
SET PortB.4 = 1
‘enable int. pullup @unused PINs, good practice
‘Set initial PIN direction and state:
DIR LED OUT
‘set direction LED to output
SET LED ON
‘turn on the LED
‘enable WDT: reset
IntOff
wdr
WDTCR.WDCE = 1
WDTCR.WDE = 1
WDTCR.WDP0 = 0
WDTCR.WDP1 = 0
WDTCR.WDP2 = 1
WDTCR.WDP3 = 0
IntOn

how low the power consumption
can be, have a look at the site of
Nick Gammon (Ref. No. 5), he did
some measures for us.

ENERGY EFFICIENT
TRANSMITTER

Let’s extend the code from the
last issue and use the power-save
mode, and the watchdog timer to
pause the transmission. The
microcontroller takes around 64
ms to start, then we set the
watchdog timer. After this, the
full circle magazine #1 38

‘turn off the interrupts - good practice to do so
‘asm inline, reset the watchdog timer
‘WDT change enable
‘enable the watchdog

‘Setting WDP[0-3] to 0-0-1-0 resets after 64 ms
‘re-enable the interrupts

program sends the LDR values over
the air. The transmission itself now
takes around 48 ms. The former
version of the program waits 8 s
without doing anything – but still
consumes power!

the watchdog timer is set to the
reset mode, and the main program
measures the LDR and sends the
data over the transmitter. Then all
of the Timer and the ADC get
switched off, and the sleep mode
power-down is enabled. After that
Here (next page, shown right) is the microcontroller is sent to
how we optimize this by using the sleep. After 8 seconds it gets a
power-down sleep mode, and the
restart, and so the same procedure
watchdog timer.
gets repeated every 8 second.
On the first start after the
microcontroller gets power, the
microcontroller is initialised. Then
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Here is the logged data from
the serial line, with the new
receiver in place, and the new
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software version on the
microcontroller. The result (next
page, top right) is good (see time
00:1 3:01 for the first dataset and
00:1 3:09 for the second dataset, as
highlighted in black).
Only a minimum of garbage is
received, so a data logging
program could easily pick up the
lines with the wanted data and
safely omit the unwanted bytes.

B READBOARD CIRCUITRY
The transmitter part is exactly
the same as in the last issue, so I
omit depicting it here again. The
transmitter has two extra PINs to
connect (than the former device):

On the left side, there is a
connector for the antenna (a wire
~ 1 7 cm is sufficient) and GND. On
the right side, there are GND, DATA
and Vcc (+5V). Both GND can be

#CHIP tiny13a, 1.2
#OPTION Explicit
#INCLUDE <SoftSerial.h>
#DEFINE ADSpeed MediumSpeed
SET PortB.0 = 1
SET PortB.2 = 1
SET PortB.3 = 1
MCUCR = 0b00010000

'include the library. This is required.

‘enable int. pullup @unused PINs, good practice
‘disable sleep modes at start

'Config Serial UART:
#DEFINE SER1_BAUD 1200
#DEFINE SER1_TXPORT PORTB
#DEFINE SER1_TXPIN 1
DIR PortB.4 IN
DIM LDR AS BYTE
'enable WDT: reset
INTOFF
wdr
WDTCR.WDCE = 1
WDTCR.WDE = 1
WDTCR.WDP0 = 1
WDTCR.WDP1 = 0
WDTCR.WDP2 = 0
WDTCR.WDP3 = 1
INTON

'baudrate must be defined
'I/O port (without .bit) must be defined
'port-bit must be defined

'turn off the interrupts - good practice
'asm inline, reset the watchdog timer

'Setting WDP0-3 to 1-0-0-1 set reset to 8 s
're-enable the interrupts

'Main program
DO
LDR = READAD(ADC2)
‘uncomment if you experience bad reception, should help to settle the transmission:
‘Ser1Send 0b11111111
‘send high value thru serial
‘WAIT 12 MS
REPEAT 3
'---preamble start--Ser1Print "#"
WAIT 12 MS
'---payload data--Ser1Print LDR
WAIT 12 MS
'---postamble start--Ser1Print "#"
WAIT 12 MS
'---new line--Ser1Send 13
Ser1Send 10
WAIT 12 MS
END REPEAT

'resend LDR-value 3 times

'send the value from the LDR

'new line in terminal
'line feed in terminal

‘uncomment because of above said reason:
‘Ser1Send 0b00000000
‘WAIT 12 MS
PRR = 0b00000011
MCUCR = 0b00110000
sleep

'PRTIM0 and PRADC = 1 / all Timer, ADC off
'SE-sleep enable, SM[1-0] sleep mode
'go to sleep mode: powerdown

‘code hereafter will never be executed because of Watchdog
LOOP
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connected with a Y-wire to the
same GND. The DATA pin goes to
the Rx-Connector of the serial-tousb-converter. Due to the shape of
the new transmitter, I hooked up
jumper wires to the connectors
and let it rest on a safe area on my
workplace. Maybe not what a
serious electrician would do, but it
worked just fine.

CONCLUSION
The initial simple receiver
module I got (without too deep
research on the subject) did its job
for our first experiments, but the
replacement I found is better. So, if
you are about to buy the hardware,
I recommend the transmittermodules (FS-1 000A) from the last
issue and the receiver-module
(RXB8, v2) from this one. However,
I highly recommend to do your
own research; there are maybe
better modules for both purposes.
The newer program saves
power, and, because some lines of
code have been saved too, it has a
little extra free space on the
microcontroller for further
optimisation and other ideas. For
the next issue, I plan to prepare a
little data logger program on the

2018-10-08 00:12:57.319486:
00 00 00 C0 00 C0 00 00 00 00
2018-10-08 00:13:01.895590:
23 38 23 0D 0A 23 38 23 0D 0A
2018-10-08 00:13:03.308992:
F8 F0 F0 F0 F0 F0 F0 F8 F0 E0
70 00 80 00 70 70 80 00 00 00
80 00 00 00 00 00 00
2018-10-08 00:13:09.867380:
23 38 23 0D 0A 23 38 23 0D 0A
2018-10-08 00:13:11.232535:
FC FC F8 F0 F0 F0 F0 F0 F0 E0
70 80 00 80 00 80 00 80 00 00

PC side, and expand the
transmitter software to send data
in larger time frames, and to
gather some real life values.

SOURCES
If you want to download the
sources instead of copy-pasting it,
you can now check it out with git
or an SVN client. Have a look at
goo.gl/aDvggr for more
information.

REFERENCES

..........
23 38 23 0D 0A

#8#..#8#..#8#..

F8 E0 F0 78 78 70 .............xxp
00 00 00 00 00 00 p...pp..........
.......
23 38 23 0D 0A

#8#..#8#..#8#..

E0 C0 F8 00 38 78 ..............8x
00 00 00 80 00 00 p...............

http://ww1 .microchip.com/downlo
ads/en/AppNotes/doc2551 .pdf
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Written by Mark Crutch

quick summary: over the past
few instalments, we’ve looked
at a couple of animation
techniques for SVG files. First was
to use the animation capabilities of
CSS, which has better support
across browsers but is limited to
animating those properties that
can be exposed via CSS (i.e. the
ones that will work in the “style”
attribute). This covers a lot of
possibilities, but does not include
many of the core attributes that
are found in SVG elements, such as
their coordinates or path
definitions. For some cases – such
as transforms – enough of SVG’s
capabilities have been added to
CSS for such restrictions to be
nothing more than an annoyance
that can be worked around. For
others, however, CSS simply isn’t
up to the task.
That’s where SMIL comes in. It’s
an older specification for
animation, created around the
same time as the original SVG
specs, and does provide the ability
to animate arbitrary attributes in
SVG. It can animate the “d”
attribute that makes up the shape

of a path, for example – a task that
can only otherwise be
accomplished in the browser via
JavaScript. But although SMIL is
more powerful than CSS in this
regard, it has never been adopted
in any Microsoft browser, leading
to its inexorable decline and a
likely deprecation in the browsers
that do support it.

pen.

strip out most of the excess
baggage from the file, just so that
this tutorial isn’t filled with several
pages of code.
Opening the file in a text editor
reveals a structure like that shown
below.

As you can see, it’s a pretty
simple file. Even the <g> isn’t really
Given this situation, we won’t
needed, but it’s easier to leave it in
look any further at SMIL, but there
place with its own transform,
The
first
thing
we’ll
need
is
a
are still a few tricks that can be
rather than try to manipulate the
path to animate. It should not have coordinates of the path to
performed with CSS that are
a fill, but will require a stroke. For compensate for its removal.
worthy of further investigation.
This time, we’re going to look at an this demonstration I’ve used
Inkscape’s star tool to create an
increasingly popular animation
The secret to this animation
technique which is really the result eight pointed star, then converted technique is in the fact that SVG
it to a path and roughly moved
of taking a simple feature of SVG
has a nice, simple, CSS-animatable
every
second
point
inwards
to
give
and pushing it in ways it wasn’t
way of drawing dashed and dotted
more
of
a
cartoon
gunshot
really intended for. It’s commonly
strokes, rather than solid ones. The
appearance. I’ve given it a strokereferred to as “line animation”,
next step, therefore, is to
width
of
2px
and
saved
it
using
the
although the line itself doesn’t
introduce some dashes, defined in
“Optimised
SVG”
option
in
order
to
change shape (remember, that
CSS. Note that you’ll probably have
can’t be done with CSS yet). It’s
also sometimes referred to as a
<svg xmlns="http://www.w3.org/2000/svg">
“self-drawing” image, which is a bit
<g transform="translate(-10 -10)">
<path d="m29 13 32 …"
more descriptive: this technique
style="fill:none;stroke-width:2;stroke:#333; …"
results in a path that appears to be
/>
drawn on the screen in the same
</g>
</svg>
way as you would draw it with a
full circle magazine #1 38
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to also remove the corresponding
properties from the path’s “style”
attribute if you saved as a normal
Inkscape file.
Save the file (top right) and
load it directly into a web browser,
and you should see something like
this:

The values we set in the strokedasharray property are used to
determine the lengths of the
drawn segments and gaps along
the path. With our value of “1 0 2 3
5” the stroke will be drawn as a
line segment of 1 0 units, followed
by a gap of 2 units, then another
line of 3 units and a gap of 5 units.
The sequence then automatically
repeats, so the next line segment
is 1 0 units long and the next gap is
2. It runs around the path
uninterrupted by corners, so a line
segment (or gap) of 1 0 might
appear as 3 units on one side of a

corner and 7 on the other – look at
the leftmost corner of the shape
for a good example of this. If you
follow the line round, taking that
into account, you can see that the
stroke dashes do follow the
pattern we’ve set.
This automatic repeating of
values in the stroke-dasharray
property produces a couple of neat
features. The first is that any odd
number of entries is effectively the
same as writing a value that is
twice as long, with the line and gap
values swapped in the second half.
So a value of “1 0 5 1 0” is the same
as writing “1 0 5 1 0 1 0 5 1 0” – in
other words a long line, short gap,
long line then a long gap, short
line, long gap. Notice that the
length of the lines in the first half
make up the length of the gaps in
the second, and vice versa.

<svg xmlns="http://www.w3.org/2000/svg">
<style>
path {
stroke-dasharray: 10 2 3 5;
}
</style>
<g transform="translate(-10 -10)">
<path … />
</g>
</svg>

and gap lengths. A lone value of
“1 0” expands to “1 0 1 0”, giving you
a repeating series of lines that are
1 0 units long, followed by gaps
that are 1 0 units long. In my
example file, that gives you
something like this:

By the time we get to 500 our
first visible line segment almost
covers the entire path. If we were
to continue increasing the value
until it is the same as the path
length, it would effectively render
it the same as if we didn’t have the
stroke-dasharray at all. And that’s
exactly what we want to do!

The other feature – and the one
we’re interested in here – is that
you can collapse the value down to
a single number to get equal line
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Now consider what happens if
we increase the value. As the
number goes up, so the visible line
segments get longer – but so do
the gaps. Below is a sequence of
screenshots of the same image
with the stroke-dasharray value set
to 1 0, 20, 50, 1 00 and 500.
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You might be thinking it’s a
little pointless to add a CSS
property, then set it to a value that
appears to have no effect, but
remember that as well as the
drawn line, there’s an equivalent
length of gap that’s not visible
because it extends beyond the end
of the path. By adding another CSS
property, however, we can adjust
the start point of the drawn
dashes, bringing our gap into play.
The stroke-dashoffset property
tells the browser to adjust its
calculations to begin further into
your stroke-dasharray sequence
(note that the “px” here isn’t the
same as screen pixels; rather it’s in
the units of the SVG file, which are
likely to be different to screen
pixels due to scaling). If your
dasharray is “1 0 5” and you set the
offset to 3px then the first
segment drawn will be only 7 units
long, then a gap of 5, then a line of
1 0 and the rest continues as
normal.

In practice this means that
setting a positive value here will
“swallow” that much of the start of
the stroke array, whereas a
negative value will “push” the
stroke array further along the
path.
By adjusting the value of
stroke-dashoffset we can “slide”
the drawn portion of the stroke
along the path. Here’s what it
looks like with values of 0px,
1 00px, 200px, 300px. Notice that
progressively larger numbers
swallow more of the path, showing
more of the gap at the end.
As you know, setting the
dasharray to the same value as the
length of the path will draw the
entire path. But also setting the
dashoffset to that value will then
swallow the drawn segment,
leaving only the gap (which is also
the length of the path). In other
words, our path will disappear
completely.

<style>
path {
stroke-dasharray: 500;
stroke-dashoffset: 0px;
}
</style>

With the drawn segment
completely swallowed, we’re at the
starting point for our animation:
our path is not visible on the
screen. By decreasing the
dashoffset value we can make the
drawn segment creep onto the
screen, following the shape of the
path. All we need to do, therefore,
is to animate the stroke-dashoffset
value (see part 75 if you need a
reminder of the animation syntax):

directly in the SVG file, it will even
work when the file is pulled into a
web page via an <img> tag.

Just a minute! Where did that
value of 575 for the dasharray and
dashoffset come from? As you’ve
probably realised, that’s the total
length of my path. You could
theoretically get it from Inkscape
via the Extensions > Visualise Path
> Measure Path… extension, but
that throws a Python error on my
Reload the file in your browser system. Alternatively you could
and you should see the effect
just use trial and error: increasing
we’re looking for – and because it’s the value of the dasharray until it
all just CSS animation embedded
just fills the path (which is quite
<style>
path {
stroke-dasharray: 575;
stroke-dashoffset: 575px;
animation-name: drawPath;
animation-duration: 5s;
animation-fill-mode: both;
}
@keyframes drawPath {
100% { stroke-dashoffset: 0px; }
}
</style>
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<svg xmlns="http://www.w3.org/2000/svg"
onload="alert(document.querySelector('path').getTotalLength());">
<style>
…

easily done using the browser
developer tools, if you’re familiar
with them).
The simplest option, though, is
to ask the browser to do the hard
work for you by invoking a little
JavaScript. There is a method on
the <path> object called
getTotalLength() which will return
the calculated length of the path.
You can call it via the developer
console in the browser, or modify
your <svg> element to call the
method when the file loads and
display the value on screen. Here’s
an example that will work for a file
with a single path:
Remember that JavaScript
won’t run when the document is
loaded via the <img> tag, so to use
the getTotalLength() method you
will have to load the SVG file
directly into the browser. You only
need to do it once, then you can
simply hard-code the value into the
<style> block and remove the
JavaScript code entirely.
There is also an alternative to

specifying the actual length of the
path. You could add a “pathLength”
attribute to the path, set it to a
value of your choosing, then treat
that value as the total length in the
CSS. This basically tells the browser
“I want to pretend this path is 1 00
units long, even though we both
know it’s not, so can you just do
the maths for me as needed”. A
good compromise is to use
JavaScript to find the actual
length, then round it to the next
whole number and set that value in
the pathLength attribute and the
CSS. That way any browser that
understands pathLength will use it
to give you a precise animation,
and those that don’t are still using
a value that’s close enough to work

in most cases.
There’s one final thing to note
with this approach. So far I’ve used
the version of the technique you’ll
most commonly find documented
online, but, according to SVG
expert Amelia Bellamy-Royds, the
definition of stroke-dashoffset in
the specification is vague enough
that not all browsers behave
identically. She suggests an
alternative of forgetting
dashoffset entirely and just
animating stroke-dasharray
instead. In this case, you need to
include two numbers in the
property as you need both the line
and the gap to change together.
My animation code then becomes

<style>
path {
stroke-dasharray: 0 575;
animation-name: drawPath;
animation-duration: 5s;
animation-fill-mode: both;
}
@keyframes drawPath {
100% { stroke-dasharray: 575 0; }
}
</style>
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that shown below.
If you want to play around with
this effect, but have the computer
do a little more of the hard work
for you, a discussion of this
technique over on
inkscapeforum.com led to one user
creating an Inkscape extension
that will add the CSS animation
code for you. You can find the
extension at
https://gitlab.com/Moini/ink_line_
animator/ and follow the original
thread at
http://www.inkscapeforum.com/vi
ewtopic.php?f=5&t=33721
Just animating a star being
drawn is a little dull, but does show
you the basic approach. Although
the star contains no curves, this
method works equally well with
any shape of path. An easy step on
from this, for example, would be to
replace the star with a path for
some handwritten text, to produce
a “self-writing” effect. Be aware,
however, that sharp transitions can
cause rendering artefacts
depending on the miter limit. In
the case of my star, for example,
the corner at the start/end of the
line flashes on and off as the rest
of the line is drawn. It’s often
better to use rounded corners and
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end caps to avoid this, which also
helps to reinforce the illusion of
the line being drawn by a pen or
pencil.
If you’re prepared to spend
more time hand-crafting your
animations there’s no reason why
you shouldn’t produce a selfdrawing SVG image consisting of
multiple paths, each animated
separately using delays to ensure
that they appear in the correct
order. Once your outline is drawn,
some more delayed animations
could fade in the fill colours, erase
some of the lines, or cross-fade to
a raster image. With time and
effort, this technique can produce
some spectacular results, and all
just by moving a dashed line
around.

Mark uses Inkscape to create three
webcomics, 'The Greys', 'Monsters,
Inked' and 'Elvie', which can all be
found at
http://www.peppertop.com/
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Written by S. J. Webb

C

entOS is the main backbone
for servers in corporations.
However, you can install a Gnome
or KDE desktop environment for
use as a workstation with a few
packages. It is not suggested for
new Linux users, just for
experienced users. So why did I
choose this OS?
It has a 1 0-year LTS cycle. It is
backed by Red Hat. A strong online
volunteer community. It is rock
solid and stable on the 3.1 8 Linux
kernel. Yet the software apps are
mature and not bleeding edge.
There are plenty of online tutorials
describing the installation,
secondary software repositories,
and updating the system. I choose
the Gnome DE since I am well
versed in it.
The hardest problem I found
running CentOS is installing an
image editor. After reading the
online forums and wiki, I installed
kdenlive. Libreoffice 5, VLC,
Firefox, and the other main
software staples are installed by
default. I then installed PHP and R
from the command-line, and

uploaded my respective batch files
for data processing.
So how do I use the software
apps in research? I use kdenlive to
edit class tutorials. I use VLC to
change the media files to different
formats as needed for websites.
Firefox for personal interbrowsing.
Libreoffice for manipulating data
sets in CSV files. GIMP and
Inkscape for scientific posters and
research volunteer study
recruitment. Rstudio to process
unique data sets for low back pain
and shoulder pain studies.

C e n t o s I n s t a lla t i o n

There are other aspects that I
methods. Linux is an international
wished I could expand upon, but
community that allows research,
those uses are not published in
corporations, and people to excel.
journals for consumption by the
general public. Once these are
published, I am at liberty to divulge
our use. So why do I use Linux in
research?
The Linux OS is portable and is
free of proprietary licenses, so any
researcher can use code or devices,
without having to contact
Microsoft or Apple. Plus the free
and open software status allows
more money to be dedicated to the
actual grant for better research

SJ Webb is a researcher coordinator.
When he is not working, he enjoys
time with his wife and kids. He
thanks Mike Ferarri for his
mentorship.
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E V E R YD A Y U B U N T U

Written by Richard Adams

BACK NEXT MONTH
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R

Written by UBports Team

ight on the heels of UBport's
OTA-4 release comes the
official 1 6.04 version of Ubuntu
Touch for mobile devices. This will
be the fifth Over The Air update
(OTA-5), and it will also be the first
of many updates that now adhere
to a regular release roadmap.
While many have already joined
the community on 1 6.04 with OTA4, in addition to the long-term
support of upstream Ubuntu
development, OTA-5 will include a
more stable experience, new
tweaks, and new features to show
off this next stage of Ubuntu
Touch development.

U PGRADING TO OTA-5 AND
WHAT TO EXPECT
Devices running Ubuntu Touch
on all UBports channels will
receive the OTA-5 update. You will
be able to update via System
Settings --> Updates.
After installing, the device will
reboot, and you will be in OTA-5.
That's it!

If you are upgrading from 1 5.04 factor you are using.
(OTA-3 or older) then you will be
greeted by a walk-through to
ensure that your devices are set up Qt Automatic Scaling
Since Ubuntu Touch currently runs
to work with 1 6.04.
on both mobile phones and tablets
(and possibly more devices down
N EW FEATURES
the road) it's important that things
display at appropriate sizes. Qt
Morph Browser
The old Oxide web Automatic Scaling will allow
engine "Browser" developers to write apps using the
Qt Quick Controls 2 and they will
app is being
display at an optimal size for the
replaced by our
new QtWebEngine form factor. Kirigami 2 widgets will
also be able to take advantage of
browser, Morph
this feature.
(formerly known
as browser-ng). "Morphing" the
Kirigami 2 (KDE widgets)
browser to QtWebEngine means
Kirigami 2 is a set of QtQuick
that the code will have upstream
benefits from the Qt company, and controls for mobile. It is a set of
components that allow developers
it uses a more recent version of
to manipulate and draw various
the Chromium engine as its base.
overlays, themes/icons, and other
This should resolve a number of
visual parts of apps. Use of this
browser issues, and make use of
toolkit will increase the chances of
new scaling features.
sharing of apps between Ubuntu
Touch and Plasma Mobile.
Morph Browser takes
advantage of Qt Automatic Scaling
COMMUNITY ART
(see below), so that the websites
you visit look the way that they are
We held a Community Showcase
supposed to no matter what form
in celebration of our journey
full circle magazine #1 38
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O T A- 5
toward this major release. Many
people responded and submitted
amazing artwork and audio
creations. These wallpapers,
notification tones, and ringtones
will be included in the OTA-5 image
and will replace some of the older
defaults. As is always possible in
UT, of course, you have the ability
to add your own custom
wallpapers and tones to expand it
as an extension of who you are.
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M Y S TO RY

Written by Tony Cladin

to get it working again. I am a
small-time computer
builder/repairman, and the way
MSI is handling my defective
motherboard has influenced my
spending habits with MSI. Not only
my spending habits, but other
builders I know have sworn off MSI
products too. Word of mouth has
influenced their circle of friends
too, which influences their circle...
We have to honor defective items
to our customers, and MSI shows
they will not, which tells us that
when an MSI product goes
Why am I even bothering with
defective, then it will be us paying
this old laptop today? I got the
new 2nd Hard Drive holder for only for a replacement. Just keep that
$1 1 NEW, and that, along with the in mind when you buy any MSI
drop in SSDs, make it now a good
addition for relatively cheap. Also,
the reason for my falling back to
using this old laptop is that MSI has
so far taken 4 1 /2 months to honor
their so-called defective warranty.
To date, I have received my socalled repaired MSI motherboard
back twice, with my motherboard
being in worse shape than when I
sent it to them for defective
replacement. It seems that MSI
thinks that a 3-year warranty
allows them to take up to 3 years
his is my old Acer Aspire 55702609 (actually a 5570z) laptop
with a T2060 1 .6 GHz CPU, 1 4.1
inch screen – that now sports 2 GB
RAM and a 300 GB Hard Drive. This
originally came with 1 GB RAM and
an 80 GB Hard Drive. I just bought
an adapter for the DVD drive to
install a 2nd HDD. With SSD prices
dropping daily, I plan to move my
current 300 GB HDD into that
adapter and install the SSD into
the original HDD caddy.
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products. Just because one of
MSI's products is defective does
not mean you will get a new or
even working refurbished
replacement. For me, so far, 4 1 /2
months have passed with me
bouncing between one computer
and another – just to bide time
with the hopes my motherboard is
repaired or the price refunded. I'd
rather have the price refunded,
just so I no longer have to play
MSI's games any longer.
I even got the dreaded Wi-Fi to
work,and it actually worked better
in Ubuntu than Vista's Wi-Fi
programs. I have finally gotten to
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the point that, once Ubuntu Studio
1 8.1 0 is released, then I will make
the total switch away from
Microsoft concerning my "i5-7400
desktop build." Why? I do not do
anything illegal, but I am tired of
Microsoft stealing my private and
personal information. I've even
started using DuckDuckGo because
it does not track you the way
Google does. I also use the much
better Opera VPN, along with the
VPN leak prevention extension.
Those two Opera extensions have
positive, heavy duty, results when
compared to Firefox, Chrome,
Internet Explorer, and Edge
browsers. I have also recently
started to use the much-maligned
TOR browser – just to maintain my
privacy even further, and it works
for "most" of my needs. Since
using Opera with VPN extensions,
and now also using TOR browser,
my spam emails have dropped to
almost nothing - zero. I've also quit
receiving daily telephone calls
from advertisers/scammers. I do
not think my almost non-existent
spam emails and no telephone
calls are just coincidence.
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W ri t e F o r F u l l C i rc l e M a g a z i n e

Written by Ronnie Tucker

G UIDELINES

T

he single rule for an article is
that it must somehow be

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

linked to Ubuntu or one of the
• Do not use tables or any type of
many derivatives of Ubuntu
bold or italic formatting.
(Kubuntu, Xubuntu, Lubuntu, etc).

RULES
• There is no word limit for articles,
but be advised that long articles
may be split across several issues.

If you are writing a review,
please follow these guidelines :

• For advice, please refer to the

When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

http://bit.ly/fcmwriting

TRANSLATIONS

• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND

If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you
access to the raw text to translate
from. With a completed PDF, you
will be able to upload your file to
the main Full Circle site.

Official Full Circle Style Guide :

GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)
document.
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REVIEWS
G AMES/APPLICATIONS

When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of five
a summary with positive and negative points

H ARDWARE

When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of five
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
36
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B O O K R E VI E W

Written by ErikTheUnready

G o d o t E n g i n e G a m e D e ve l o p m e n t

I was really looking forward to
this book. I skipped straight to
page 39, What is Godot? I glued my
eyes to my screen - as I got the
electronic version and did not look
up until my eyes were well and
truly tired. This book should be
your companion if you are new to
Godot.

The second project is 'escape
the maze'. This introduces us to
things like layers and enemies and
a few more nodes. Now not broken
up into parts any more but
continuing with what you have
learned.

Each successive project makes
use of more of the engine until the
The explanations are clear, and last project 3D mini golf, where
there are illustrations on almost all you get a gentle introduction into
the topics. (When I say
3D. You get to use everything you
illustrations, I mean clear
learned in 2D plus things like 3D
screenshots of where you should
cameras. A small chapter at the
be working.)
end titled "Additional topics"
touches on things like shaders. Do
Godot Engine Game Development
After a well-written
not expect a book for Unity
Projects
introduction into the Godot
developers; this book is squarely
By: Chris Bradfield
Interface, we are taken to the first aimed at the beginner and does so
project, 'coin dash'. We are told
very well. The book feels personal.
ISBN 978-1 -78883-1 50-5
NOT to skip this chapter. In this
Throughout the chapters, I felt as if
41 3 Pages
chapter, some of the explanations the Author was talking to me
answered quite a few of my
alone.
hat I really like about the
questions regarding Godot and
Godot engine is that you can GDscript. The chapter is broken
After books like "SAMS teach
have something working within a
into five parts, each dealing with a yourself Godot Engine Game
day, not finished, but able to see
part of the game. You learn as you Development in 24hrs" - that was
some output. Even if it is just the
go along and end up with a silly
written by a team of people - with
basics with the blue robot PNG file game and much clearer
more projects, this book is a breath
as a sprite.
understanding of the Godot
of fresh air. The book also has a
engine.
full circle magazine #1 38
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very familiar feel, as if I have read
it before, but somewhere else,
about something else. I may be
imagining this or it may be the way
the book was structured. Each
successive project builds on the
others and at no point do you feel
lost. It is also easy to go back and
look up something you have
forgotten.
This book, however, does not
dive into topics like networking,
but I promise you will have as much
fun as I had making my "own"
games in Godot. I felt like a kid
who could not wait to try
something new. This book is a
great starter to your Godot
journey and I can freely
recommend it.
Four stars - and that's only
because I wanted more on
GDscript. (Since I am not a
programmer, the "man" pages do
not make a world of sense in
Godot.)
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LE TTE RS

If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org .
PLEASE NOTE: some letters may be edited for space.

Join us on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine

FULL CIRCLE 201 8
SURVEY
It's that time of the year
again where we ask what
you think of FCM, Ubuntu,
and Linux.
Some questions are a
requirement, some you can
skip over if not applicable.
Your answers will help
shape Full Circle, so please
use your constructive
criticism. If you don't tell us
what you think, or what
we're doing wrong, then
we won't know.

Survey URL:
http://bit.ly/fcm201 8
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twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/forum
display.php?f=270

FULL CIRCLE N EEDS YOU !
Without reader input
Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.
See the article Writing for Full
Circle in this issue to read our
basic guidelines.
Have a look at the last page of
any issue to get the details of
where to send your
contributions.
contents ^
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Q &A

If you have a Linux question, email it to: questions@fullcirclemagazine.org ,
and Erik will answer them in a future issue. Please include as much
information as you can about your query.

Compiled byEriktheUnready

elcome again to another
issue of FCM! In this section
we will endeavour to answer your
questions. Be sure to add details of
the version of your operating
system and your hardware.
I will try to remove any
personally identifiable strings from
questions, but it is best not to
include things like serial numbers,
UUID's or IP addresses.
Because of the possibility of
bad English, spelling, and grammar,
I will correct these for Q&A. It just
reads better for our readers, and is
not intended to change your
questions in any way. If you are not
sure about you spelling, etc, you
can run your question through
Google translate.
Years ago, I had an end user
come into the OEM I was working
for and walk up to the workshop
counter. As my technicians were
busy helping offload the container
with our stock, I went over to the
"customer". As we mainly dealt
with resellers, and I was sure I
knew them all, I approached this
person carefully. After the

pleasantries were out of the way,
the person put a stiffy disk (1 .44
MB) on the counter, and asked if I
could load the internet on it for
them.

bubbling capacitors on the main
board (and have them replaced)
and try another power supply.

well as the icon theme. I am going
to assume Gnome – as you did not
specify a desktop environment.
The desktop icons shrink and grow
in Gnome when you resize them in
: I would appreciate your
Nautilus. Know however, there is
advice regarding how to work also a minimum and a maximum
I do not know if I kept a straight
around a Ubuntu 1 6.04.5 problem. setting. 33% in 1 6.04, if I
face, but I tried really hard!
The desktop icons got too large
remember correctly. In Ubuntu
after I updated from 1 6.04.1 .
1 6.04, CCSM (Compiz Config
These icons are >1 " in size and are Settings Manager) is also still an
: I am getting an error in
too large for my laptop screen. I
dmesg readout: BUG: soft
option, so is dconf-editor if you do
lockup - CPU#1 stuck for 23s! BUG: tried to shrink them down, but the not mind getting your hands dirty.
soft lockup - CPU#2 stuck for 23s! methods that I tried, without
"org>gnome>nautilus>icon_view" .
BUG: soft lockup - CPU#3 stuck for success, include the following:
You can also use gconf-editor. You
• Resize icons to the minimum by
23s! BUG: soft lockup - CPU#4
can even go to "preferences" in file
right-clicking on them.
stuck for 23s! What can this be?
explorer (Nautilus) and change the
• Use Dash/Files, select the second default zoom level. Please also
icon at the upper right corner, then know that the minimum size,
use the slide bar to reduce the
: In my experience, that
hardcoded into Gnome is 48px. ----icons to the minimum possible size. however ---usually means you have a
• Hold down the Control Key and
hardware error or misconfigured
BIOS. You did not say if this error is rotate the mouse wheel
This problem has taken me on
forwards/backwards.
coming up and the system works
another journey; I cannot
fine, or the error prevents you
reproduce the "large" error,
Please advise. Thank you in
from using your computer. If it is
however I find that my testing on 4
advance.
preventing you from using your
PC's produced the opposite: no
computer, then, go into the BIOS,
matter how I changed my Nautilus
do a BIOS reset to defaults, and
icons, my desktop icons would
: There are many ways to skin remain 48px. I suspect we need to
turn off things you do not use, like
a cat, but first note that the
floppy drive controllers and serial
log a bug report.
desktop environment matters, as
ports. If it is a desktop, look for

Q

Q

A

A
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a .run file. I
: I have little freezes in
Q :amHowuseddo toI install
windows, but new Q Ubuntu. Most notably, when
to Linux.

playing music, it will just freeze for
a few seconds, then continue
without giving an error. I have run a
: Linux file permissions are not fsck on my drive twice, and
the same as you were used to installed proprietary drives, to no
on windows. The ".run" part is for
avail. The only thing I see is the
you, not the computer. The file will time out: "Timed out waiting for
work even without the extension. device dev-disk-by
To execute a file in Linux, you have xxxxxxxxxxxxxxxxx". Sometimes
to assign it ‘execute’ permissions.
my mouse won't even move and
Right-click on the file and go to
sometimes only my mouse moves. I
properties. Select the permissions have a Dell Optiplex 770 with a
tab, and tick the checkbox marked 250GB Seagate drive and 4GB of
"Allow executing file as program". RAM with a Geforce 21 0.
Welcome to the world of freedom!

A

I want to minimize all my
Q :windows
to the taskbar like I

do in windows, but I don't know
how to add it to the dash. I run
Ubuntu 1 8.04.1 , with standard
install, on an Acer Travelmate with
4 GB memory.

A

: There is none that I am
aware of. I replaced my dash
with Plank, and that has the option
to add a "show desktop" icon to
your launcher. Super and d also
does that.

I cannot get my mouse
Q :pointer
to sync. Is there a way

to calibrate it? It keeps missing my
window by a mile. I have looked for
the synaptic utility, but I didn't find
it. I have a custom mouse pointer
theme installed, but even if I
uninstall the theme and use stock
pointers, dmz-black or dmz-white,
it still does it. It is frustrating when
you have windows tiled against
each other. You cannot tell where
one ends and one begins.

A

: What you are describing is
the same issue I have. I
: Even though fsck reports no
suspect you have vanilla Ubuntu
errors, what is happening is
that the drive is struggling to read 1 8.04 installed. However, I have
the platters. You have two options: this issue only when windows are
you can back up your data and do a over each other or next to each
low level format (this may take all other, not single use. I can suggest
installing only an Ubuntu "flavour"
day and not fix your problem), or
you can replace the drive and be on by Canonical that does not fire up
Gnome. Ubuntu Mate is a very
your way. Some people swear by
Spinrite, a commercial program to popular option. There are tutorials
low level format your disk. I tried it on installing "vanilla" Gnome on
the internet as another option.
once with a small disk - 80 GB I
think it was - and it ran all day and
night, so I am not sure how long it
: I have a file with a .install
will run on 250 GB. You can also try
extension which I want to
the low level utility from Seagate.
open, but I don't know how. I have

A

Q
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a 32-bit sub-system installed if that
helps. Oh and I am using Ubuntu
1 7.1 0.

A

: Firstly, look at my answer
above, on the .run file. Now
go to the folder where the file is
stored. Right-click and click "open
in terminal". With your terminal
open, type: file <the name of your
file here> (you can use tab
completion), and you will see that
Linux will tell you what kind of file
it is. You can read up more about
the file command in the man
pages; it is one of the few man
pages with decent descriptions.

I have an HP 1 4-AN001 NA
Q :laptop.
I've installed Ubuntu

1 8.04 in dual-boot, but it is not
showing any wifi which is in the
next room. In Windows, it is
showing all networks and
connecting full bars. lspci says its a
realtek RTL8723BE PCIe.

A

: The notebook laptops have
two pigtails coming from the
wireless modules. Generally they
go via the hinges to the screen and
around the outer edges. One is the
primary and one is secondary
contents ^
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pigtail antenna. HP, in their
wisdom, has decided that they can
save 1 c on every laptop in your
range by omitting one of these
pigtails. You have two options,
one, swop the pigtail to the other
pin, or two, tell the driver which
antenna you are using in the
/etc/modprobe.d/rtl8723be.conf
file. Just add "options rtl8723be
ant_sel=2" (0r sel=1 , depending if
it is connected to primary or
secondary)

name only. Mark it for installation,
and it should mark the
: Install mate-tweak and run it. dependencies. Now click on apply.
If you use a GUI, there is sunflower,
Select "Panel" on the rightdouble commander,
hand-side and click the Save As
mucommander, etc.
button, choose name for the
current layout (for example,
Familiar-broken), click OK and then
: After upgrading from 1 7.1 0
select the default layout from the
: I recently got a new router
to 1 8.04, I get screen tearing
drop-down menu again (for
from my ISP that has 5 GHz
when I run a movie in SM Player as
example, Familiar). Click between
WiFi, but my potato laptop does
well as VLC. In MKV format and
the two to make sure you choose
not see the 5 GHz SSID. Is it Ubuntu the correct one.
MP4 and AVI format. I have a
or my dell lattitude e4300? It runs
core2duo with nvidia gfx and 4 gig
Ubuntu minimal install and has 2
memory. CPU usage is high, but
: My Ubuntu was upgraded
GB of memory with intel display.
not too high, and memory usage is
: I am trying to add Midnight
from 1 6.04 to 1 8.04 with no
80%. Temperatures are med-high.
Commander, but I get the
issues. However, my startup times
error:
and shutdown times are longer. My
: According to the Intel
Reading package lists... Done
startup applications are: 1 . anydesk
product brief, the Intel card
: Remove (purge) your nvidia
Building dependency tree
tray, 2. komorebi, 3. MPD, 4. Safe
does support 5 GHz. A quick trawl Reading state information... Done
driver and reinstall either 3.04
Eyes, 5. Snap user application
on the internet show that that
for
older
cards or 3.90 for newer
Package mc is not available, but is
autostart helper, 6. SSH key agent. functionality is not on by default,
cards.
referred to by another package.
802.1 1 b/g is default, and you need This may mean that the package is
apt-get remove --purge
I have not used snaps before, so it switched to a/b/g. I am afraid I
missing, has been obsoleted, or is sudo
nvidia-*
I think it could be snaps. The df
don't know how to accomplish this available only from another source.
command brings up too many
in Linux, but you can switch it with
snaps to list. What am I doing
the Intel utility in Windows if you
wrong?
dual-boot.
: Install synaptic package
manager. Go to settings,
repositories, and make sure the
Erik has been in IT for 30+ years. He
: Run the command: ‘systemd: I am missing icons in my
top 4 checkboxes are ticked. If not,
has seen technology come and go.
From repairing washing machine
analyze blame’ and look at the
panel. They were there before. it will reload the package
sized hard drives with multimeters
output. Nine times out of ten, your Any information is appreciated,
repositories. Now go back to the
and oscilloscopes, laying cable, to
computer is waiting for something thanks! Ubuntu mate 1 8.04 LTS.
main window and search for mc in
scaling 3G towers, he's done it.
from the network (test this by
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turning off WiFi and unplugging
the network cable when booting).
Also try the command: ‘systemdanalyze critical-chain’. This should
highlight the waiting ones in red.
You can also look at a program
called bootchart.

A

Q

Q

A

Q

Q

A

A

H

U B U N T U G AM E S

T e kke n 7

Written by Oscar Rivera

aving had Steam surprise us
last month with SteamPlay, I
figured that, for this month, it
would be best suited if we put our
money where our mouth is. So,
having a brand new plethora of
games from which to choose, I
selected a game recently made
available on Linux – thanks to
SteamPlay. With Tekken 7 on sale,
it was an easy choice for me
(regular price is $49.99 through
the Steam Store) so I bought it,
downloaded, and installed it. To
my pleasant surprise, Tekken 7
plays really well on Linux.
Tekken 7 is a fighting game
(think Mortal Kombat, Street
Fighter, etc). This is actually not
the seventh, but rather the ninth
game in the Tekken series. Tekken
7 was originally released as an
arcade game in Japan back in
spring 201 5. Eventually, in June
201 7, the game was released for
PlayStation 4, Xbox One &
Microsoft Windows. As of August
201 8, thanks to Valve’s SteamPlay,
Tekken 7 is now available for Linux.

SteamPlay was a breeze. There
were no extra steps needed. Just
install the game as I would install
any other Steam game. One
recommendation AND precaution
that I would add is to look through
the SteamPlay Compatibility
Report. One of the main reasons I
decided to go with Tekken as the
first SteamPlay game I review was
because of the high rating it
received on the SteamPlay
Compatibility Report. At the time,
the rating was Gold (only Platinum
is higher) but it has since been
downgraded to Silver (which is still
pretty good). Having installed the

game, there was still the doubt as
to how it would play, especially
because it took a little too long to
load the first time but I suppose
that’s to be expected. I can now
launch the game and actually
begin fighting within a couple of
minutes (there are still cinematic
cut-scenes that need to be
manually skipped by pressing a
button), which is what is to be
expected from most fighting
games.
Tekken 7 can best be played
with a game-controller but you can
also use mouse/keyboard. Like

most fighting games, there are
basic moves you can perform and
then there are more complicated
moves that require a combination
of buttons to be pressed in
precisely the right order. Anyone
who’s ever played a fighting game
in the past will be able to adjust to
Tekken 7 just fine. Having done
most of my playing with a gamecontroller, I can attest that Tekken
7’s controls are very responsive
and smooth. Every movement my
character made was carefully
crafted by the previous
combination of buttons I had just
pressed on the controller.
The graphics on this game are
pretty awesome, both during the
actual fighting as well as in the cutscenes. In fact, out of all fighting
games I’ve played on Linux, I’d say
this one has perhaps the best
graphics, best sound, best voiceacting, and it’s also very creative in
how it deals with various attackmoves & combos. One of the cool
things about this game is that it
can be enjoyed as a 1 -player game,
multi-player (locally), or onlinemulti-player, and the experience is

Installation for this game via
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nearly the same. In other words, all
three of those formats I
mentioned are just as exciting with
Tekken 7.
There are two ways to play a 1 player game; the first is to play the
Story Mode while the second way
is to play Offline (which is Story
Mode minus the story). For those
who enjoy Online matches, you’ll
be pleased that there are a couple
of different choices for online
playing. For example, you can play
just for fun, or you can play and be
ranked. If you’re being ranked, that
means that the game servers are
keeping track of your
performances and are ranking you
so that you’re paired up with
players at more or less your level.

Then, if you’re daring, and ranked
play is getting too boring for you,
there is an Online Tournament
Mode that you can play which
basically explains itself.
All in all, I really like playing this
game. As I stated earlier, I would
probably have to say that this is
the best Linux fighting game I’ve
ever played. As seen in the
SteamPlay Compatibility Report,
not everyone has enjoyed this
game as much as I have; and indeed
I did encounter a minor bug (but
then again, can we call it a bug
being that the developers never
intended for this game to be
played on Linux?) which was that
every single time I would stop
playing the game, then it would
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get stuck at “Syncing”, and the only
way to fix this was to restart Steam
(so a bit of an inconvenience).
Other than that, I encountered no
other problems (as long as
resource-hungry Chrome is not
running in the background).

Minimum Requirements:

• 64-bit CPU
• OS: Windows 7/8/1 0 (Linux under
Steam-Play)
• CPU: Intel core i3-41 60 @
3.60GHz or better
• RAM: 6 GB
• GPU: Nvidia GeForce GTX 660 2
GB, GTX 750Ti 2 GB or better
• Network: Broadband Internet
Connection
Oscar graduated from CSUN, is a

musician, game enthusiast and has
been working with Bitcoin and other
alt-coins. You can follow him at:
https://twitter.com/resonant7hand
or email him at:
7bluehand@gmail.com
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P AT R O N S
M ONTHLY PATRONS
201 6 - Present:

Bill Berninghausen
Jack McMahon
Linda P
Remke Schuurmans
Norman Phillips
Tom Rausner
Charles Battersby
Tom Bell
Oscar Rivera
Alex Crabtree
Ray Spain
Richard Underwood
Charles Anderson
Ricardo Coalla
Chris Giltnane
William von Hagen
Mark Shuttleworth
Juan Ortiz
Joe Gulizia
Kevin Raulins
Doug Bruce
Pekka Niemi
Rob Fitzgerald
Brian M Murray
Roy Milner
Brian Bogdan
Scott Mack
Dennis Mack
John Helmers

JT
Elizabeth K. Joseph
Vincent Jobard
Joao Cantinho Lopes
John Andrews

201 7 - Present:

Matt Hopper
Jay Pee
Brian Kelly
J.J. van Kampen

201 8 - Present:

John Helmers
Kevin O'Brien
Kevin Raulins
Carl Andersen
Charles Stewart
Dave Nelson
Brian Bogdan
Dennis Shimer
Leo Paesen

SINGLE D ONATIONS
201 8:

Yvo Geens
Graig Pearen
Carlo Puglisi
James A Carnrite
John Holman
P G Schmitt
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Robert Cannon
Thomas A Lawell
Ronald Le Blanc
Luis Eduardo Herman
Glenn Heaton
Peter Swentzel
Alain Mallette
Christophe Caron
Linda Prinsen
Ronald Eike
Anthony Cooper
Louis W Adams Jr
Joseph Tong
Robert G. Wells
Robert Kaspar
Thomas Gambier
Peter Fitzsimons
Terry O'Neill
Brian Kelly
Tobias Nannen
Julian Watts
J.J. van Kampen
Ralph DeMarco
Robert Kaspar
Kenneth Watson
Terry O'Neill

44

The current site was created thanks to
Lucas Westermann (Mr. Command &
Conquer) who took on the task of
completely rebuilding the site, and
scripts, from scratch, in his own time.
The Patreon page is to help pay the
domain and hosting fees. The yearly
target was quickly reached thanks to
those listed on this page. The money
also helps with the new mailing list that
I set up.
Several people have asked for a PayPal
(single donation) option, so I’ve added a
button to the right side of the website

A big thank you to all those who’ve
used Patreon and the PayPal button.
It’s a HUGE help.

https://www.patreon.com/
fullcirclemagazine

https://paypal.me/ronnietucker

https://donorbox.org/recurring
-monthly-donation
contents ^

Full Circle Team

H O W TO CO N TRI B U TE

Editor - Ronnie Tucker
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FULL CIRCLE NEEDS YOU!

A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's,
reviews, and anything else you want to tell your fellow *buntu users.
Send your articles to: articles@fullcirclemagazine.org

Deadline :

Sunday 1 1 th Nov. 201 8.
Release :
Friday 30th Nov. 201 8.

We are always looking for new articles to include in Full Circle. For help and advice
please see the Official Full Circle Style Guide : http://bit.ly/fcmwriting
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our site via: fullcirclemagazine.org

For the Full Circle Weekly News:

Webmaster - Lucas Westermann
admin@fullcirclemagazine.org

Editing & Proofreading

Mike Kennedy, Gord Campbell, Robert
Orsino, Josh Hertel, Bert Jerred, Jim
Dyer and Emily Gonyer
Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

Getting Full Circle Magazine:
EPUB Format - Most editions have a link to the epub file

on that issue's download page. If you have any problems
with the epub file, email: mobile@fullcirclemagazine.org

You can keep up to date with the Weekly News using the RSS
feed: http://fullcirclemagazine.org/feed/podcast

Issuu - You can read Full Circle online via Issuu:

Or, if you're out and about, you can get the Weekly News via
Stitcher Radio (Android/iOS/web):
http://www.stitcher.com/s?fid=85347&refid=stpr
and via TuneIn at: http://tunein.com/radio/Full-Circle-WeeklyNews-p855064/
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ronnie@fullcirclemagazine.org

http://issuu.com/fullcirclemagazine. Please share and rate
FCM as it helps to spread the word about FCM and Ubuntu.

Magzster - You can also read Full Circle online via

Magzster: http://www.magzter.com/publishers/Full-Circle.
Please share and rate FCM as it helps to spread the word
about FCM and Ubuntu Linux.
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